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About This Document 
This guide is for EIC system administrators. It assumes a reasonable understanding 
of DP terms and concepts. and that you will have attended the Basic MAPPER User 
Workshop. 

Purpose 

The EIC Administrator's Guide is designed for the people who will be responsible for 
the running of a EIC system. This guide explains the functions of the EIC system 
and how to use them. 

How to Use this Guide 

The document covers the following general topic areas: 

1. Introduction 

Containing an overview of the system and some special features that make it 
unique. 

2. Usage and Management 

Sections detailing how to establish and maintain the system and its various 
functional components. 

3. Education 

An overview of the user and information provider education requirements. 

4. Reference Information 

Containing technical and "help" resource information, plus details of each 
associated application. 

Related Product Information 

EIC Users Reference Manual 
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Section 1 

Introduction to EIC 

1.1 Overview 
As organisations grow and change it is very difficult to meet and maintain the 
information needs in the work place. The information in question is the operational 
and business information that allows people to keep up with what's happening in 
the organisation or corporate body, carry out their job role or provide their routine 
reports to management. 

Over time a whole range of different systems may be established, generally as a 
result of specific computing facilities in place to service finance and administration, 
sales, marketing organisations, etc. The day to day needs of an organisation beyond 
this are generally seen to be served by various word processing and secretarial 
support facilities, spreadsheets on local PC's, etc. 

In many organisations electronic mail or information access systems of various types 
are used to get information to staff, but these are generally not consistent in their 
structure and are often ad-hoc in nature. These often come into being in response to 
some management cry to 'do something.' 

The proliferation of these systems is a real problem for people in an organisation 
(especially new staff) making it very difficult for them to meet their quality 
objectives. 

1.1.1 The EIC Solution 

EIC is intended to provide a general solution to the management of the business 
information flow in an organisation. This flow is seen as outwards from the 
corporate entity and inwards to the corporate entity from the field. 

The EIC application provides a 'toolbox' of basic functionality which may be 
manipulated and structured by a system administrator to meet the particular needs 
of an organisation. This functionality is intended to satisfy the 'real world' needs of 
people in the work place and requires no technical intervention to manage it. 

EIC can be used as a 'front-end' to other applications so that it may manage access 
and security requirements in a structured way. Other applications can be developed 
very quickly using EIC to manage security and user registration. 

EIC can be used to display data from an external application or from a specific 
external MAPPER cabinet, drawer & report (mode, type, rid). This means that 
management reports or charts which are maintained by external applications may 
be easily presented to users. 
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EIC allows a 'workbench' type facility to be structured so that novice stan can oe 
guided to the information and systems areas they need to do their job. 

EIC is written in MAPPER and runs on Unisys 2200, A-series and UNIX platforms. 

EIC 2.0 implementation emulates a 'windows' environment for non-intelligent 
terminal support and is CUA standards compliant. 

EIC 3.0 provides full graphics user interface capabilities (Designer Workbench - 
12/92) 

1.1.2 Information Providers 

Information is supplied to the system by information providers. In most cases 
information providers can only provide information to those areas of EIC that are 
relevant to their job role. 

1.1.3 Users 

Information is accessed by users, who can display information, but not change it. 
Exceptions are found in public access areas of the system, for example bulletin 
boards, conferencing, electronic maiL 

People may be information providers in some instances, users in others. 

1.1.4 The Administrators Rote 

Your role will be to ensure the smooth operation of the system. Apart from 
supporting the system functions, hardware operation, system resources, etc., you 
will help information providers to make sure their information is organised properly 
within the structure of EIC and you will help users by making sure they have access 
to the information they need. 

To do so, you will need to keep in touch with what information is coming into the 
system, where it is put, how menus are structured, how documents are cross-
referenced, who has access to it, etc. 

As you become more familiar with the system, you will realize what an important 
part you play in its effectiveness. 

1.1.5 Documents 

Information in EIC is usually represented as straight ASCII text, without 
formatting, and is kept in documents. Documents can be organised in and attached 
to menus. Documents can be assigned keywords to let users search for information 
based on a particular subject. You can assign "profiles" to documents to restrict 
access to them. You can also attach a summary to a particular document, which 
gives a brief overview of what the document is about. 
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1.1.6 InfoGroups 

The sources of information entered in EIC are ebissified into "InfoGroups". Each 
InfoGroup has an owner registered within EIC, who is responsible for the 
information that goes into the InfoGroup, that is, information provided by the group. 
An example of possible InfoGroups for an EIC site might be: Sales, Support, 
Manufacturing, Design, Finance, Administration and so on 

1.1.7 Menus 

There are two independent types of menus in EIC. The first is used to help you 
specify what the program should do next. In this guide, it is called "The Menu Bar". 
The Menu Bar appears at the top of each screen and contains a number of headings 
for different types of actions. When you select a heading from the Menu Bar its 
corresponding action list is displayed. It lists all the possible actions that can be 
initiated. 

The other type of menu is concerned with the representation of information in EIC. 
In this guide, it will retain the name "menu". 

EIC menus are use to represent the organization of the information within EIC. 
That representation depends not only on the information itself, but also on the 
profile of the individual user. A user whose profile defines a wide view of 
information will see more content in the menus than a user with a narrow view. 

1.1.8 MyMenu 

The structure of menus in EIC is a hierarchy, which can be several levels deep. As 
well as the predefined menu which users see when you first use EIC, there is an 
individual custom menu for each user, called "MyMenu". A user can alter the 
content of their individual MyMenu at any time, to represent the areas of 
information they access most frequently. As well as documents and summaries, a 
user's "MyMenu" may include menu names and provide access to other applications. 
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1.1.9 News 

As new documents are added by information providers, they can be nominated for 
inclusion in the News area. The decision to include the document may be made by 
the provider or by you. 

At any time, system users can Select 'News" from the Window pull-down menu on 
the Menu Bar to list the News, i.e. new documents that have been added to the 
system. 

New material which is relevant only to a small group of people should not be put in 
the News area. News documents are usually listed in reverse date order. They 
remain on the News list for 60 days. (Other documents normally remain in the 
system for up to 2 years). 

1.1.10 Keywords 

Keywords are attached to menu items to help users find information on a specific 
subject, and can be assigned for any type of menu item (documents, sub-menus, 
etc.). A command is provided to display valid keywords. 

EIC also uses profile keywords to define profiles, but these are explained later. 

1.1.11 Profiles 

Profiles are used to manage users' access to menu items. They can: 

• Reflect job roles within the corporate structure; 

• Define the job roles of a user; 

• Define access for a menu item. 

When defining job roles within the corporate structure, a profile is simply a 
collection of profile keywords which represent roles within the organization. The 
profile database may be organized into a hierarchy, to better represent the structure 
of those roles. 

When defining the job roles of a user, a profile is a list of profile keywords which 
have been assigned to that user. This defines which areas of information they have 
access to. 

When defining access for a menu item, a profile is a table of profile keywords. The 
way in which the keywords are organized on the table defines which profile 
keywords a user must have in order to be able to access the menu item. 
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Example: 

Sales may be a parent keyword to Sales Exec, Sales Group 1, Sales Group 2. 

Everyone working in Sales will have the Sales keyword in their profile which 
will let them access general information in the Sales menu. However, only 
members of the specific groups will have the respective keywords in their 
profiles, that allow them to look at sensitive information. 

You, as administrator, and the information providers must make sure that 
information is correctly protected by being assigned the correct access 
keywords to match the user profiles. 

1.1.12 Screens 

Within the context of EIC, a screen is the rectangular area immediately below the 
Menu Bar and above the command line. 

When you are looking at menus, the screen contains a list of sub-menus, documents 
or other menu item types (explained later). 

When you access a document or other item, the screen contains the contents of that 
document. If the screen is not big enough, you can use the function keys to scroll 
through its contents. 

1.1.13 Forms 

Forms defined in EIC act as data entry templates, where the data is automatically 
posted to a pre-set destination, or the application program it was designed for. 

1-5 



1.2 	Liaison with the MAPPER Coordinator 
This is one of the most important jobs of the EIC administrator. Generally, the 
MAPPER coordinator is responsible for all of your computer resources. Effective 
communication of your resource requirements is essential so that you can provide 
the necessary services to your users. 

There are two main areas which you need to discuss with our MAPPER coordinator. 
These areas are the EIC user base resource requirements and advice on technical 
issues, for example linking other applications to EIC. 

1.2.1 User Resource Requirements 

Both you and the MAPPER coordinator need to be aware of: 

• The number of EIC users; 

• The processing time and storage space that they require, and the charging 
mechanism for those resources; 

• Peak usage times, when users make the greatest load on processing resources; 

• What the system response time is like; 

• Increasing storage requirements, and how to manage the problem of running 
out of space, if it should happen; 

• Feedback from users on these issues. 

1.2.2 Advice on Technical Issues 

You may have to deal with technical problems which you have not encountered 
before. You may need to refer to the MAPPER System Administration Guide. 

If a solution to the problem is not readily apparent the next step is to consult your 
MAPPER coordinator. 

1.3 Setting Up a Menu Structure 
When you first log on to EIC, you should see a default menu structure already in 
place. 

You should initially work within the existing menu framework, but you can easily 
modify the structure at a later date. See the section "Designing Your Menu 
Structure" later in this guide for details 
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1.4 Managing Users 
For new users, you need to: 

• Explain what EIC can do for them; 

• Give them a copy of the EIC User's Guide; 

• Enter their details into the user database, and set up their access profile. You 
may also need to amend the profile database to cater for new roles. The 
procedure for adding new users is covered in a later section of this manual. 

• Ensure that users receive adequate training This training should cover all the 
material in the User's Guide, and ideally it should be done by someone who 
uses EIC the same way the new user will. If the user is also to be an 
information provider he/she should have a good understanding of the structure 
of menus, and understand profiling of documents, and when and how it should 
be done. 

As advanced users become familiar with EIC, they may want to assist in creating 
documents and managing information. In this case they need to have a full 
understanding of the relevant parts of EIC and will work cooperatively within the 
framework of your existing system. 

1.4.1 Managing Data 

The aspects to managing data on EIC are: 

• Grouping 

• Profiling 

• Identifying 

• Structuring 

• Database Maintenance 

Grouping 

You should set up InfoGroups so that they reflect the general grouping of 
information within the corporate structure. InfoGroups are necessary so that 
responsibility can be defined for data. You can assign up to 36 assistants to help the 
InfoGroup owner manage the InfoGroup. 

Profiling 

Profiling is done to control access to information. You will need to set up the profile 
database so that the profile keywords reflect appropriate user roles. You will also 
need to ensure that the hierarchical structure of the profile database reflects the 
roles within the corporate structure. Information providers should set up profiles on 
any documents that they bring into EIC when the information should be seen only 
by a specific group of users. This should be done when the document is created or 
imported, and not left to a later date. 
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Identifying 

Identifying is the process of assigning appropriate keywords and descriptions to 
items brought into EIC. This process includes summarizing where necessary and 
assigning appropriate keywords and descriptions to the data. This will assist users 
to find relevant information (wieldy 

Structuring 

Structuring is organising information into a hierarchical system of menus and sub-
menus. As new information is added, you may need to change the existing menu 
structure to better represent the new data. When you do this, you should make the 
distinctions between the all of the items within the menu clear to everyone using 
EIC. 

Database Maintenance 

You should always keep the user database and profiles up to date. Entries should be 
added for new users as they require access to EIC, superseded information updated, 
and profiles changed as user job descriptions change. 

You need to update the system tables, which contain the organization and cost 
centre codes. This should be done when initially setting up EIC, and then whenever 
the organization codes change. 

You should ensure that the Administrator Contact Screen accurately indicates to 
users who they should contact if problems arise. 
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Section 2 

Using EIC 

2.1 Logging On 
The instructions that follow take you from the initial logon screen. 

I Unisys RAPP= System 35RIC15 I 
I PACO - PARD PRODUCTION mama 

Station: 50205 System: 35 I 

Please enter the following information, 
or press SignOn to sign on as a new user. 

I User-id 
I 	Dept # 	 I 
1 Password 
1 	 1 

Press QCT when complete. 

iSignOn 21-Aplip 5 	4 	5 	6ReaMile 7 	Map 9 	10Rxit 

Figure 2-1 MAPPER Logon Screen 

2-1 



trlIfSiiNCIII I 
MERINIFOIMMEECTROOk.  

      

   

TRACK 

      

      

U3 

1:g 
=WE R ENC1F "Too U CT 	VMS 

D FiGCT CRY CALL 	%Aria ansh 

EDU 04110N 3 Or MOPE 

Using EIC 

2.1.1 Logging On to the System 

1. Type in your User-ID, department number, and password 

2. Press XMIT 

If you experience difficulties in doing this, please contact your EIC assistance 
number. 

The first EIC screen is displayed. It will look similar to the one shown below. 

IPM"  "-N. 
	 7 • 	 ;,:.7,:•!,,Z7,47M7,7;07:”7:71 

:t.14(  „ 
ie iNt View eptens 'mods*" 	Nibs'  

Figure 2-2 First EIC Screen 

Once you have logged on, you can use EIC according to your needs. 

The following pages explain the basic layout and use of the EIC screens and the next 
section of the manual gives some step by step examples that you can follow. 
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2.2 EIC Screen Layout 
The Common User Access standard has been used to develop the EIC interface 
which, in turn, accesses databases kept on a Unisys Mainframe. Using EIC is 
sinviiRr to using many other packages available on PCs. 

There are some basic elements of the screen layout that you need to know about: 

Menu Bar 
	

Menu Code 
	

Ti eBay 
	Menu Title 

Screen 
Display 
Area 

Figure 2-3 Screen Layout Basics 

Features to note: 

Title Bar 

Title of application selected. 

Menu Code (Item Number) 

A unique code that identifies a menu. (Example, AUS:MAIN1). 

Menu Title 

Title or description of the menu. 

Menu Bar 

This shows the titles of action lists you can select to manipulate or view 
documents or screens. When you select a title from the Menu Bar, a list of the 
available functions is displayed in a "Pull-down" Menu. 



CINFO/SY:MAI 

Icon 

Icon Menu 

Using EIC 

Screen Display Area 

The screen display area may have different formats e.g. Icon Menus, Menu lists 
or Documents. 

Icon Menu 

A window containing icons representing the various options/applications 
available 

Figure 2-4 Screen Icons 

Features to note 

Icons 

Each icon represents an option which may be selected. 

Icon Name 

The Primary Keyword to identify this menu entry. 
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Menu List Box 

A window containing individual line entries for the various options/applications 
available . 

Locate Button 

CINFIY5y:LN512 
. 	 IdSS' 1184MCEM 

Line: 61 

../11N1111 
61 OMR 
62 VMS 
63 SEMINNI 
64 SERIA 
65 MIX 
66 MIX  

International Banking 	 928618 INEY16 
Teleannunialtions Services: Users Perspective 9268113 Hill 
Unix The Tedrology Catalyst For You-  Enterprise 92111318 MEV 
Insurance 	 926618 111E111 
Solution Development In An Uncertain Uarld 	9266IB WEWI 
Unisys To Base deskt Lire al Unix SY114.2 	MIEUB XVI 
New Cenerat ion tl 	TP lhix Transaction Mgr 	28618 ltElill 

Scroll 
Bar 

11S1v 
• AWA:a44.1513tis 	1q.>.41ft.,44. Ok* jai  

InfoGroup Code 
Date Created 

Entry Title 
Primary Keyword 

Item Number 
Menu Entry Descriptor 

Figure 2-5 Menu List Box 

Features to note: 

Menu Entry Descriptor 

Signifies the type of menu entry. Each type is described on the following page. 
The complete list is: 

A 	Application 
	

Link to an external application; 

M 	Menu 	Link  to another menu screen; 

D Document 
	

Standard text document; 

F 	Form 
	

Predefined input form (e.g. ordering); 

S 	Summary 
	

Summary description of the Link contents; 

G 	Graphic 
	

MAPPER graphics or chart; 

B Bulletin 	Bulletin Board Area; 

P Picture 
	

Bit-mapped Graphics Image. 
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Item Numbers (1,2,3,etc.) 

Enter the desired Item number in the command field to select that item, e.g."4" 
displays item number 4. 

Primary Keyword 

This is the primary keyword for the item and is indicated to assist you in 
targeting information on a particular menu screen. 

Entry Title 

This is a single line name or description of the item. 

Date Created 

This is the date that the item was added to the menu. 

InfoGroup Code 

This is the code for the InfoGroup to which the item belongs. 

Locate Button/Input field 

Use this function to locate any text/value on the window. 

Scroll Bar (to the right and at the end of the window) 

The scroll bar is a proportional mechanism and is used to move the viewing 
window to the section of the document you want to examine. 
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Document 

A document is displays as 80 characters of ASCII text. Scroll bars are available 
on the right side and the end of the window if it is not large enough contain all 
the text. 

Menu Bar Scroll Bar 

file 	Yaw SP-nrrn Ben liehl 

      

intIMIIIMISM=MIMMililiZI ROM iiIIIMIMMMUIIMMIMMIBEMIO •=1=111=Mb.. 	  

It Sagest 1921 

UNISYS PI1PPER R POLISHED PERFOIffER RT SUM 41 

Salvias business problems with Mapper, the decision support tool Fron 

Unisys. will be the theme of the Inisys stand at Ant 11. 

Unisys mill demonstrate how Mapper can transfern neasingless computer data 

ists charts, tables and pictures for vegetative analysis and decision 

=insert, with an actual Mapper application developed by an international 

sporting gonds company to automate its warehousing operations. 

Figure 2-6 Document Display Screen 

Features to note: 

Scroll Bar (to the right and at the end of the window) 

The scroll bar is a proportional mechanism and is used to move the viewing 
window to the section of the document you want to examine. 
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2.3 	Navigating the Screen 
When an EIC screen is displayed use the mouse pointer to move around the screen 
and menu bar. When the pointer is positioned at the appropriate place rlielt once to 
initiate the action - eg an option on the menu bar or an icon on the icon window. 

NOTE 

On a menu list box you must click twice to action an item or else click once to 
highlight the item and then press 'MIT. 

2.3.1 Selecting a Menu Item - Icon Menu 

Use the mouse to move the pointer to Icon required. Click once (i.e. press the 1st 
button on the mouse) to act on that item. 

If the item is a menu that menu will be displayed. If it is a document that document 
will be displayed. 

2.3.2 Selecting a Menu Item - Menu List Box 

Use the mouse to move the pointer to the description area of the menu item 
required. Click once to highlight the item . Double (-lick (ie press the 1st button on 
the mouse twice in quick succession) to action that item. Alternatively after 
highlighting the item press XMIT to action it. 

Use the Locate function on the list box to locate any value on the menu list box. Use 
the mouse pointer or TAB key to move to the locate entry field. Enter the text/value 
to locate and XMIT or move to the Locate button with the pointer and click, to locate 
the item required. Click or Xmit again to locate the next occurrence of the item. 

For some actions initiated at the Menu Bar you may need to "Mark" the menu item 
on which you want the action taken. Mark and Unmark are described later in this 
section. 

2.3.3 Menu Bar Options 

The options available to you on the Menu Bar change according to the screens you 
are using. Basic headings found on the Menu Bar include: 

File 

Edit 

View 

Options 

Window 

Admin 

Help 

Other actions may be available on some screens, e.g. When you are creating a note 
on your NotePad a Search menu is available. 
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2.4 	Using the Menu Bar 

1. Move the pointer to the appropriate Menu Bar heading. 

2. Click once. 

Basic Menu Bar Pull-down Menus 

File 

NotePad 
New Item... 
Import... 
Title and Options... 
Access Security... 
MaiL.. 
Download 
Add to MyMenu 
Exit from the System 

Edit 

Mark 
Update Document 

Options 

My Profile 
My InfoGroup list 
Date Format 
Language 
Summary Info 

Help 

Index 
Using Help 
Information Owner 
System Problems 
About EIC System  

Admin 

System Message 
Act As... 
Profile Maintenance 
InfoGroup Maintenance 
User Registration 
System Tables 
System Options 
Reports 
Document Pool 
Waste Basket 

View 

Find... 
Keyword list 
Sort by 

Window 

Previous Menu 
Main menu 
My Menu 
News 

Figure 2-7 Basic Menu Bar Pull-down menus 

2.4.1 Selecting an Action from the Menu Bar 

1. 	To access a Menu Bar item move the pointer to the required menu bar title and 
click once. The pull-down menu containing the actions for that menu title will 
be displayed. 

• Actions that cannot be initiated are 'greyed out'. This is because 
that action is inappropriate at this screen or because you do not 
have the appropriate user profile. 

2-9 



Using EIC 

• Actions which have a follow on input screen have '...' after their 
title. 

• Actions which have a follow on cascading menu have '>' after their 
title. 

2. 	Move the pointer to the required action and clink  once. 

To cancel a Menu Bar pull-down click  on the Menu Bar pull-down title. 

On any Menu Bar pull-down different options will be available on different parts of 
EIC e.g. when editing a document. 
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Using EIC 

2.4.2 File Pull-down Menu - Movement of Documents 

Use the File pull-down menu to manipulate complete documents or files, add menus 
or items to menus, maintain security levels, import or export documents or exit the 
system. 

Figure 2-8 Options available under File on the Menu Bar 

NotePad 

Displays your existing NotePad area for editing. 

New Item... 

Adds new menus, documents, forms, bulletins etc to the system. 

Import... 

Imports documents from other systems/hosts and puts them in specified 
InfoGroups. 

Title and Options... 

Change titles and options on existing documents. 

Access Security... 

Set or change access security levels on existing documents. 

Mail... 

Mail a document to a mailbox. 

Download 

Down load a document to your PC. 
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Add to MyMenu 

Add a menu/document to your own menu. 

Exit from the system 

Exit from the EIC system. 

2.4.3 Edit Pull-down Menu - Document/Menu Editor 

Use the Edit pull-down menu to update existing menus, forms and other EIC 
document& 

An›:0:4:4,...,5.4\4•,..?„:,-;.; • Wasim— 	 wind  aw Atom 	  
tidA 1511E APti!- 

Figure 2-9 Options available under Edit on the Menu Bar 

Mark 

Marks the item on which you intend to perform some action. 

Paste 

Places items from the buffer (as result of Cut, Copy or Move) into the menu on 
display. 

Update Document 

Takes you into the update mode to update a document. 
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2.4.4 View Pull-down Menu - Changing Your View 

The View pull-down menu provides facilities to locate and manipulate data in the 
document currently on display. 

Bic 

Keyword Ilst 

4-41-144—":1;:z SD 3 

AN 110 ONCE 	GO 

JOSM 

DO hFE RE NOT,  PRODUCT 

D !RECTORY 	SALE 

d: 1.0 

MILL-TN 

TRACK 

VARS 

[CA 

EMI:DIEN IDFTWAR E 

Figure 2-10 Options available under View on the Menu Bar 

Find... 

Finds a particular string of data - up to 40 characters in the text. 

Keyword list 

Displays a list of available keywords for a document - provides direct selection 
capability. 

Sort by 

Sorts the data by one of the keys displayed on the cascading menu. 

>1 Key (Ascending) 
2 Key (Descending) 
3 Subject (Ascending) 
4 Subject (Descending) 
5 Date (Ascending) 
6 Date (Descending) 
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2.4.5 Options Pull-down Menu - Setting Personal Options 

The Options pull-down menu allows the user to personalise some of the system 
parameters such as Date format and Terminal screen Colour preferences. Two 
options are provided which are essentially for problem analysis and administrator 
use - these show the User's system access profile and the Information Groups 
(InfoGroups) which they may access. 

The Options facilities will gradually be expanded as the system develops. 

Figure 2-11 Options available under Options on the Menu Bar 

My Profile 

Admin use, indicates the user's system profile. 

My InfoGroup 

Admin use, indicates the information areas accessible. 

Date Format 

Allows the User to select a new date format from the date formats displayed on 
the cascading menu. 

>1 System Default 
	

5 YYMMDD 
2 YY.MM.DD 
	

6 DDMMYY 
3 DD-MM-YY 
	

7 MMDDYY 
4 MM/DD/YY 

Language 

Allows the User to select a new language from the languages displayed on the 
cascading menu. 

>1 English 
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Sunimnry Info 

When this flag is selected then subsequently when any menu item is chosen 
summary information for that item (if available) will be displayed before the 
details of the menu or document. 

2.4.6 Window Pull-down Menu - Changing to another Menu 

The Window pull-down menu allows the User to change to a different Menu or 
display new items. 

Figure 2-12 Options available under Window on the Menu Bar 

Previous Menu 

Displays the previous menu that the user accessed. 

Main Menu 

Displays the Main Menu for this application. 

MyMenu 

Displays the User's MyMenu. 

News 

Displays any new news items in the EIC 

1 Unisys InfoCentre Electronic Centre 

All previously selected menu titles are listed and any one may be selected. 
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2.4.7 Admin Pull-down Menu - System Maintenance 

The Admin pull-down menu provides the facilities for maintaining the system, 
updating system tables, maintaining user registration, and producing management 
reports. 

Figure 2-13 Options available under Admin on the Menu Bar 

System Message... 

Enables the administrator to enter a message which will be displayed to all 
Users under the News menu bar option. 

Act As... 

Enables the Administrator to act as some other user by changing to that user's 
User-ID. 

Profile Maintenance 

Enables the administrator to add, modify or remove profiles on the Profile 
table. 

InfoGroup Maintenance 

Enables the administrator to add, modify or remove InfoGroups on the 
InfoGroup table. 

User Registration 

Provides access to the user registration functions of add, modify or delete user 
details, and the account and Application Maintenance functions through the 
menu. 
>1 Add, Modify Detnils 

2 Account, Application 
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System Tables 

Provides update facilities for the tables listed in the cascading Menu. 
>1 Cost Centre 

2 Organisation 
3 Distribution List 
4 Spawning Menus 
5 Remote Users 
6 Admin Contact Info 

System Options 

1 Date Format 
Allows the User to select a new date format from the date formats displayed in 
the cascading menu. 
>1 Date format>1 YY.MM.DD 

2 DD-MM-YY 
3 MM/DD/YY 
4 YYMMDD 
5 DDMMYY 
6 MMDDYY 

2 Language 

Allows the User to select a new language from the Language displayed on the 
cascading menu... 
2 Language > English 

Reports 
Provides access to management reports on user profiles, resource utilisation, 
and operations. 

Document Pool 

Displays the Document Pool menu. The document pool is a holding area for 
menus, documents, forms etc received into the system but not yet assigned to 
an InfoGroup. 

Waste Basket 

Displays the contents of the wastebasket for a specified InfoGroup. 
Wastebasket contains documents, bulletins etc retired from the active menus. 
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2.4.8 HELP Pull-down Menu - The System Help Area 

The Help pull-down menu allows the User to gain access to the various Help and 
assistance areas established in EIC. 
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Figure 2-14 Options available under Help on the Menu Bar 

System Help Index 

Index and access to System help documentation. 

Local Help Index 

This is local application specific. 

Admin Help Index 

Index and access to Administration help documentation. 

Using Help 

Displays information about using the EIC help system. 

Information Owner 

Information about the owner of the current screen. 

System Problems 

How to report system problems/gain assistance. 

About EIC System 

General information about your system details 
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2.5 Marking a Menu Item 

For some actions, you need to nominate the item or document that you want the 
action taken on. This is called marking. 

You mark the item and then initiate the action. 

To mark an item: 

1. Display the menu that lists the item; 

2. Select Mark from the Edit pull-down menu; 

3. Move the pointer to the description area of the item to be marked and elirk 
once (press the first button on the mouse). 

The marked item is highlighted. 

To mark a number of individual items at the same time: 

1. Mark the first using the pointer and click; 

2. Move the pointer to the next; 

3. Mark that one, repeat the process as required. 

2.6 Unmarking a Menu Item 

Move the pointer to the item to be unmarked; 

Click once to unmark a marked item. 
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2.7 	Using the Scroll Bar 

Scroll bars may appear to the right of a window and at the end of a window. You 
can use the scroll bars to scroll through a long list or a long document, and to shift 
your view to the left or right. 

Scroll bars contain arrows at either end. 

• Move the pointer to the arrow pointing in the direction required and click  

• Click once to move one line ( or one row if horizontal scroll bar) or hold the 
mouse button down to scroll continuously. 

Scroll bars contain a scroll box. This can be used to move to a particular part of a 
document. Move the pointer to the scroll box, click once and holding down the mouse 
button, drag the scroll box to the required position on the scroll bar and release the 
mouse button. The document is now displayed at a section (vertical or horizontal) 
corresponding to the position of the scroll box on the scroll bar. 
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2.8 	Searching for Information - 
the View FIND Command 

When new information is inserted in the EIC system, the Information Provider may 
optionally insert the document in the News list (accessed by News on the Window 
pull-down menu) as well as being indexed under the targeted menu. 

News items would typically stay in the system for 60 days (retention periods are 
established for each menu screen by the System Administrator) and within the 
system for a maximum of two years. Apart from looking for general information in 
News, you will often want to look up: 

• Information about a particular subject. Enter an appropriate keyword. 

• Information that was created by a particular person (this is the person's 
MAPPER user-ID, not their surname). 

• Information that was created around a particular date range. 

EIC lets you search for information using any of these criteria or a combination of 
them. If your first search finds 40 documents, but can only display 20, you can use 
scroll to roll to the next document. In most cases you will only search using 
keywords. For each document, the keywords - up to 25 - are checked to see if they 
match the one you entered. 

Figure 2-16 The Find Window 

To search for information 

1. Select Find from the View pull-down menu on the Menu Bar. 

2. Enter your search criteria and press XMIT, or click on the OK button. 
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2.9 	Finding the Correct Keyword 
If you don't know which keyword you want to use, eliek  on the Keyword List button 
to display a list of valid keywords like the one that follows: 
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Figure 2-17 List of Valid Keywords 

This list of keywords can be displayed at any time by selecting Keyword List from 
the View pull-down. Once you have found the keyword you want, move the pointer 
to it then Mick  or press TRANSMIT. You will then be presented with a Menu list of 
all documents registered as having that keyword. You may repeat the process to 
narrow down the document list. 
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2.10 Special Facilities 

2.10.1 MyMenu 

This is your personal menu. Documents or menus that you commonly use can be 
added to MyMenu making access to them quicker. Note that you cannot add an 
external application - these can only be accessed via a system menu. 

You can delete items from your MyMenu that you no longer use. 

2.10.2 Switching Between MyMenu and Other Menus 

MyMenu is available from the Window pull-down on the menu bar. 

• Select Window from the menu bar. 

• Move the pointer to MyMenu and dirk. Your MyMenu will be displayed. 

• Use the Window pull-down to move from MyMenu to another menu or go back 
to previous menu. 

2.10.3 How to Add an Item to MyMenu 

An individual item or group of items may be added to MyMenu. These may be menu 
entries, documents or application links You may not copy individual conference 
items or.items from the main menu on your MyMenu screen. 

When items are added to MyMenu (that is by marking them at the menu screen 
level), all keywords, security characteristics and summary information is 
automatically moved with the marked items. 

Adding to MyMenu from the Menu Screen Level 

1. Move to the menu screen of interest; 

2. Go to the File pull-down menu; 

3. Select Add to MyMenu; 

4. Mark the items required and elirk  on the OK button. 

All selected items will be copied to your MyMenu. 
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2.10.4 To Delete an Item from MyMenu 

1. Select MyMenu from the Window pull-down menu; 

2. Select Mark from the Edit pull-down menu; 

3. Mark the item(s) to be deleted; 

4. Click on the Delete button; 

5. A confirmation box will be displayed. To delete the item click  on YES 

The marked items will be deleted. 

2.10.5 What's New 

This facility is simply to let you know what information has been released to the EIC 
system and is available on the Window pull-down menu. 

• Select Window 

• Select News 

You can use the Find option (under View on the Menu Bar) to list all news items 
with a particular keyword. If you find a document that you want to "keep", you can 
copy it to your MyMenu. 

If any system messages exist which have not been previously displayed to you, then 
these will be displayed in a message box when you select news. 

2.10.6 NotePad 

NotePad is a work area for compiling your own notes to send to associates using 
electronic mail. 

Each user has one NotePad "document". Whenever you select NotePad from the File 
list on the Menu Bar, your NotePad is displayed. It will contain the same 
information that you entered prior to your last save of the document. 

NOTE 

NotePad notes cannot be added to MyMenu. 
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2.10.7 To Create a NotePad Document 

1. 	Select NotePad from the File pull-down on the Menu Bar. 

A screen like the one below is displayed showing your NotePad. The first time you 
access NotePad it will be blank; otherwise it will contain the last notes you created. 

Lc4:-P144:404-7kPAR411gfglk.:0101ERAWW4 	Rt's;i4.1.14.4A  
file Edi view Searth Rae Help 
Notepad text area 

Figure 2-18 NotePad Showing the File Options 

Any data may be entered directly on to the screen. Use the Menu Bar options to 
manipulate text. 

NotePad Menu Bar Options 

File Pull-down Menu 

New 	 Open a new NotePad file. 

Open 	 Open an existing NotePad file. 

Merge 	 Add one NotePad file to another. 

Save 	 Save the NotePad on display in a file. 

Save as 	 Save a file as another file. 

Preferences 	Change default file settings. 

Print 	 Print a NotePad file. 

Page setup 	Change default page settings for printing. 

Printer setup 	Change default printer setup. 

Exit 	 Exit NotePad. 

Edit Pull-down Menu 

Undo 	 Undo the last change made to the document. 

Cut 	 Cut the marked lines from the document. 

Copy 	 Copy the marked lines from the document. 

Paste 	 Paste the cut to copied lines into the document. 

Delete 	 Delete the marked lines from the document. 

Select All 	Mark all lines in the document. 
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View Pull-down Menu 

Tabs 
	

Set the number of rows for tab insertion. 

Wordwrap 
	

Set the flag for text to wrap around the screen. 

Search Pull-down Menu 

Find 
	

Find first occurrence of a string of data. 

Repeat Find 
	

Find next occurrence of a string of data. 

Change 
	Change a string of data to some other string of data. 

Goto line 
	

Go to a specified line number 

Run Pull-down Menu 

Options 
	Enter or change a program name and the Windows command 

to call a program. 

(run name) 
	

Any program name entered in options will then appear on 
the Run pull-down menu and may be initiated by selecting it 

Help Pull-down Menu 

Index 

Keyboard 

Commands 

Procedures 

Using Help 

About PowerPad  

An index of the NotePad help available. 

A description of the function of keyboard keys in NotePad. 

A description of the commands available in NotePad. 

A description of the procedures to use in NotePad. 

An explanation on how to use NotePad help. 

Information about this version of NotePad. 

2.10.8 Managing the NotePad Document 

When you call NotePad your existing NotePad area is displayed. 

Enter Text/Data as required . Use the actions in the Edit pull-down to move data 
around the document Use the pointer to mark data lines. Marked lines may be cut 
or copied or deleted. 

To Move text to another location 

1. Mark the lines to be cut/copied. 

2. Select Cut or Copy from the Edit pull-down - Cut moves the lines to the new 
location, copy duplicates the lines at the new location. 

3. Mark to line where you want to insert the lines. 

4. Select Paste from the Edit pull-down menu. 
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Using EIC 

To Delete text from the NotePad 

1. Using the Pointer Mark the lines to be deleted. 

2. Select Delete from the Edit pull-down. 

NOTE 

You cannot delete a NotePad. 

Saving changes to NotePad 

When you have finished updating the document select Exit from the File pull-down 
menu. If the NotePad document has been changed a Save confirmation screen is 
displayed. Click on Yes to save any changes. 

While a user has one NotePad "document" on the EIC system, you may use the New, 
Open and Save As function on NotePad to open a separate NotePad or save a copy of 
NotePad as a file on your workstation. 

2.11 Help 

On line help for the EIC system is available under the Help pull-down on the Menu 
Bar. 

The Help pull-down menu is available throughout the EIC system. 
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Figure 2-19 Help Pull-down - EIC Help 

Options available on the Help pull-down menu 

Index 

Provides an index to the System, Local and Admin help 
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System 

Provides help information on various functions in the EIC system - eg MyMenu 
or News . The topics available are displayed in a list box from which you may 
select one using the pointer. 

Local 

Provides help information on various local applications available on your EIC 
system. The topics available are displayed in a list box from which you may 
select one using the pointer. 

Admin 

Provides help information on various Administrator functions available on the 
EIC system. The topics available are displayed in a list box from which you 
may select one using the pointer. 

Information Owner 

This is the name and telephone number of the information owner, that is the 
person responsible for this area of EIC or the person who actually provided the 
information. 

System Problems 

Provides the names and phone numbers of the people to contact if you need 
assistance. 

About EIC System 

Current user-BD, name and telephone number, current run name, version, 
remote site-ID and language. 

2.12 Print 
Menus or documents may be printed on your local printer. Menus may first have to 
be downloaded to your workstation using the Download option. 

1. Select Print on the File pull-down menu. If there is no Print option select 
Download and then repeat step 1. 

2. Printing will now be initiated. A message will be displayed showing the 
destination printer. You can cancel the print process by clinking on the Cancel 
button. 
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2.13 Mail 
Menus or documents may be mailed to a mail box. 

1 	Select Mail on the File pull-down menu. 

Figure 2-20 Electronic Mail Input Screen 

2 	On the input screen displayed enter Sender, Subject, Priority, To (dir-id) or To 
(list) and optionally Copy(dir-id) or Copy (list). 

3 	Click on OK When mailing is complete you will be returned to the menu or 
document. 

2.14 Download 
Menus or documents may be downloaded to your workstation. 

• Select Download on the File pull-down menu. 

The downloaded document will be displayed. You may now save the document as a 
file on your workstation by using the Save or Save as action on the File pull-down 
menu. 
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Section 3 

Information Management 

	

3.1 	Management Policy on Information 
Distribution 
As a general rule, information in EIC is available to all users. Restrictions on 
information distribution is determined by information providers, and by 
management. As an Administrator, it is your responsibility to implement those 
policies through the use of profiles and keywords. 

3.1.1 Distribution Channels for Corporate Information 

You will need to identify your main information providers and set up menus that 
reflect the type of information they will be submitting, but also to reflect the way in 
which it will be accessed by users. 

For example, product announcements and press releases issued by the marketing 
department may be attached to the main menu under their respective titles. 
However, users may only be interested in announcements that are relevant to 
particular products or topics. 

You will need to make sure that the information providers are aware of this fact and 
that they attach keywords that are meaningful for product/topic oriented users. 

	

3.2 	Where the Information Comes From 

3.2.1 Submissions From Local Sources 

Information providers working on your local system will create documents and add 
them directly to the system. You need to make sure they fully understand the 
structure of the menus and you may need to inspect their initial submissions. 
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3.2.2 Submissions From Remote Sources 

Information providers working on remote systems will have a MAPPER utility for 
creating documents and attaching appropriate keywords. They will then have to 
assign it to a screen number within your system. Each screen or document is 
assigned a unique identification number in the following format: 

EIC/SY:22PM1 

Where: 

EIC/SY 	equates to the unique EIC system identifier 
(Network System - ID). 

22PM1 	is the unique screen or document number. 

Information providers may be submitting documents to a number of EIC systems, 
each with its own menu structure, and they need to keep a list of the correct screen 
numbers for each. 

Two types of information providers may exist in your organisation. 

• 'Trusted' providers who are known to the home system administrator and who 
may be given the right to send documents to their own screens without 
administrator examination. 

• 'Non-trusted' in the sense that they may be general users or outside the direct 
supervision of the local system administrator. 

Documents submitted from a 'non-trusted' source must be 'vetted' by an InfoGroup 
Administrator. 

3.2.3 Procedure for Reviewing Remote Submissions 

In the standard EIC system deliverable, a Document Pool capability is provided so 
that any document sent to the EIC application by a non-trusted Information 
Provider will be trapped for examination by the System Administrator. This would 
be especially applicable to general documents routinely sent to a distribution list. 

Access to the Document Pool menu is achieved via the Admin pull-down menu. 

In this implementation, once the Administrator has determined that the document is 
acceptable, it is placed in the appropriate menu area by using the Mark and Copy 
functions. 
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3.3 	Other Information Sources 

3.3.1 File imports 

Files may be imported into EIC from a remote site, by you or an information 
provider. These files can be unformatted ASCII text files, MAPPER graphic files, or 
host-specific data files. See "Import" in the Administrator's Reference Manual for 
details. 

An example of this is chart runs which are managed externally but supply data to 
EIC for display. 

	

3.4 	Where the Information Goes To 
EIC information can be output in the following ways: 

• By printing; 

• By the screen; 

• Through electronic mail; 

• By facqimile; 

• By exporting to the local system via MAPPER; 

• By exporting to the host-system; 

• Downloading to a local terminal (host system dependent). 

3.4.1 The Screen 

The most common form of output is the terminal or workstation display. 

3.4.2 Electronic Mail 

In the standard EIC application, documents from EIC may be sent to any 
destination supporting MAPPER electronic mail. Some installations may have other 
electronic mail systems, so detailed procedures are not contained in this manual, but 
left to you to arrange with your MAPPER co-ordinator. 

You can then document these details and advise users in a Help document. 

3.4.3 Facsimile 

If the facility is implemented EIC documents may be sent as a facsimile. Discuss 
your sites procedures and advise users. 
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3.44 Exporting to Workstation 

Any document within EIC may be exported to your Workstation by using the "Save 
As" option in the File pull-down on the Menu Bar. This function is only available 
when the document to be exported is displayed on the screen. If the "Save As" 
function is not available (e.g. when the document is a menu) use "Download" on the 
File pull-down menu to initially download the document on to the screen. 

"Save As" saves the document on a file on your workstation. 

When exporting, EIC keeps no references to the fact that the information has been 
exported. 

	

3.5 	Where the Information is Stored 
Usually, EIC data is stored on the local host machine. When several sites run EIC 
and share their data, data viewed from a terminal connected to a local host may be 
stored on a remote host. This issue is unimportant to the user, but you should be 
aware of it, as it will have a major bearing on storage requirements. 

Refer your queries to your MAPPER co-ordinator. 

	

3.6 	MAPPER - What you Need to Know to Manage 
EIC 
You do not need to have a deep understanding of MAPPER in order to manage EIC 
effectively. However, functions such as creating forms require ,a knowledge of 
MAPPER reserved words such as TIME$, DATE$, USER$ etc. These reserved words 
are covered briefly in this guide in the section "Creating forms". You can find a full 
reference to them in the MAPPER documentation. 
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Section 4 

Setting up the System 

4.1 	EIC System Sizing Guidelines 

Limitation of Total Menu Items 

System 

No system limitation on the total number of menu items. The system 
administrator may assign maximum growth constraints for any particular 
menu. 

InfoGroup 

System Administrator defines how many menu items may be assigned within 
an InfoGroup - up to 99,999 items. 

Menu 

The InfoGroup owner (defined by the EIC System Administrator) or the EIC 
Administrator defines the maximum number of items allowed for each menu 
within the InfoGroup. 

The total number of menu items is counted as RESERVED for each menu. 
Total of RESERVED items cannot exceed the preset limit for the InfoGroup. 

Database 

A MAPPER Drawer cannot exceed 2,000 reports. Multiple Drawers may be assigned 
for the User database, should the area required exceed the capacity of a single 
Drawer. 

EIC System Runs and Tables 

- Number of Cabinets required 	One 

- Drawer descriptions Drawer 	Record Length 

        

System Screens 	 F 	 80 
System Tables 	 G 	 80 
System Help Docs. 	 H 	 80 
System Runs 	 I 	 80 
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User Database 

There are nine (9) database types within EIC, with each database having one or 
more MAPPER Drawers. Alternatively, one MAPPER Drawer may be assigned for 
multiple database types. 

The Database types are: 

User Tables 

User Lists 

Menus 

Documents 

Forms 

Conference Area 

Bulletin Board 

NotePad 

Graphics 

History 

Workarea 

Binary Files 

User Tables 

Record length = 80 characters. 

Two (2) new reports (Index Table & Wastebasket) are created for each new 
InfoGroup. 

The first twenty (20) reports are reserved by the system (InfoGroup registration, 
User registration, User Profiles, etc.). 

User Lists 

The User List contains a User's detailed information such as User Profile, InfoGroup 
accesses, User defined colour scheme, Application environments, etc). 

Multiple access drawers may be required if the number of Users exceeds 2,000. 

Record length = 80 characters. 

Number of MAPPER reports equals the number of Users. 

One (1) new MAPPER report is created in this drawer and two (2) in another drawer 
for every new User registered. (NotePad in User NotePad drawer and MyMenu in 
User Menu drawer). 
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Menus 

Record length = 100 characters. 

Number of reports = number of menus + number of Users (MyMenu). 

One (1) new report is created for every new menu. 

Multiple drawers may be required if there are more than 2,000 menus established in 
the system. 

Documents 

Record length = varies according to site needs (80 - 256 characters). 

Number of reports = Number of Documents. 

One (1) new report is created for each NEW document in the system. 

Separate MAPPER Drawer(s) can be assigned for the following situation where a 
document is created by the EIC IMPORT or by the external CREATEDOC functions. 

Maximum and Minimum number of lines for a Drawer (e.g. 0-500,501-2001,2001-
10,000). 

Maximum and Minimum width - i.e. Number of characters (e.g. 0-80, 81-132) 

Forms 

Record length = 80 characters. 

Number of MAPPER reports = Number of pre-defined forms. 

It is recommended that one of the Drawers assigned for Documents be used if only a 
few forms are required. (A Drawer of 80 characters and less than 500 lines is 
recommended.) 

Conference Area 

Record length = 100 characters. 

Menu, Conference area and Bulletin Board are treated as a menu and have the 
same report format. This means that all menu types can share the same Drawer. 

It is recommended that one of the Drawers assigned for Menus be used if only a few 
Conference areas are to be utilised. 
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Bulletin Board 

Record length = 100 characters. 

Menu, Conference area and Bulletin Board are treated as a menu and have the 
same report format. This means that all menu types can share the same Drawer. 

It is recommended that one of the Drawers assigned for Menus be used if only a few 
Conference areas are to be utilised. 

NotePad 

Record length = 80 characters. 

One (1) new MAPPER report is created in this drawer for each new User. Multiple 
MAPPER Drawers are required if the number of Users exceeds 2,000. 

Graphics 

Record length = 80 characters. 

MAPPER Graphics code is stored in this drawer. 

History 

Contains a history of EIC system usage. 

Record length = 80 characters. 

Number of reports = 62. 

Workarea 

Used as a holding area for documents being updated manually. 

Record length = 80 or 132 characters ( two Drawers required) . 

Number of Mapper reports = one per document. 

Binary Files 

Used to hold user defined Designer Workbench Icons. 

Record length = 132 characters. 

Number of Mapper reports = As required by users. 
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Example Database Configuration 

.e 	User's Drawer list 
*Maker Description 	Drw Typ Min Max ttin 	Max Max 

CO 41 Lines Lines Rept 

User Tables 	 b842 TAB 
User List 	 c842 UL5 
User Menus 	 d042 PVI 
User Conference Area 	0642 ARE 
User Bulletin Board 	d842 BUL 
User Conference 	e042 COM 
User Documents 	88 e842 DOC 
User Documents 	132 i842 DOC 
User Forms 	 88 e042 FOR 
User Graphics 	88 8042 GRA 
User Binary files 	132 1842 6K5 
User MotePad 	88 e842 PAD 
User lbrk Area 	88 b820 LW 
User Lbrk Area 	132 c828 LPN 

COMPORT 

IResume 2Paint 3 
	

4Return 5 	6ya5ks 7Uiew $Nelp 

Figure 4-1 Example Database Configuration 

NOTE 

Maximum Reports Size. 

It is recommended that this limit be set to 90% of the MAPPER limit for the 
maximum allowable number of reports. This is to allow for storage of updated 
copies. 

4.2 	Creating System Entities 

The following procedure creates your system entities (InfoGroups, users, etc): 

Basically, you need to: 

1. Enter organisation codes; 

2. Enter cost centre codes; 

Organisations and cost centre codes must be established before you can create 
InfoGroups; 

3. Enter Profile Keywords; 

Profiles must be created before you can create users and information providers. 

4. Enter details of information providers; 

5. Create InfoGroups; 

6. Enter details of users with high profiles (other users can create their own user 
records). 

To establish these entities, use the options available under Admin on the Menu Bar. 

After these entities are created, you need to create menus and load documents, etc. 
These procedures are discussed later in this section. 
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Figure 4-2 Administrator's Pull-down Menu 

4.2.1 Organisation Codes 

You must register at least one organisation code. Organisation codes are used to 
produce management reports for monitoring such things as system usage. You can 
use these reports to determine how often documents are created, how often they are 
accessed, what storage capacity is being used and what may be required in future. 

For installations that provide services for a single organisation, you only need to 
create one organisation record. 

To Enter an Organisation Code: 

1. Choose System Tables from the Admin pull-down menu. 

2. From the cascading menu displayed select Organisation. 

A screen like the one below is displayed. The instructions are listed at the end of the 
screen. 
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Organization D!script ion 

0000 	MEDIA System 
0042 	U31S 
0101 	Quality System 
0505 	Australia 

Select an Organization code you want. 
Then click on the appropriate command button. 

Setting Up the System 

Figure 4-3 Organisation Codes Screen 

3. Click on the Add button to add a new Organisation Code. 

4. A window is displayed in which you enter the new Organisation Code & 
Description. 

.. . 

Organization ...... 	AMOrwmw7M 	  

Description ...... 

Figure 4-4 Add Organisation Window 
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5. Enter the code you want to use and the name of the organisation; 

6. Click on the OK button or press XMIT. 

7. Use Exit on the File pull-down to return to the menu. 

4.2.2 Cost Centre Codes 

Cost Centre Codes are used in management reporting so you can determine which 
departments are providing information to the system, which departments are using 
the system, how much storage they use/require, and how much processing time they 
use. 

Cost Centre Codes should be assigned to coincide with the cost centres of your 
organisation. You can refine them at a later date. 

To Enter Cost Centre Codes 

1. Choose System Tables from the Admin pull-down menu. 

2. From the cascading menu displayed, select Cost Centre. 

A screen like the one below is displayed, listing the registered Cost Centres. 
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Figure 4-5 Cost Codes Screen 
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3. 	Click on the Add button to add a new Cost Centre code. A window is displayed 
in which you enter the new centre's details. 

• . 	. 

Figure 4-6 The Add Cost Centre Window 

4. Select an Organisation Code from the List Box and enter Cost Centre Code and 
description. 

5. Click on the OK button or press XMIT. 

4.2.3 Admin Contact Information 

Use the Admin Contact Info option on the System Tables cascading menu to enter 
contact information. 

Figure 4-7 Admin Contact Information Screen 

You should enter relevant details so that anyone using EIC is able to contact you 
about problems that they might be experiencing. 

When you have set up the data structures within EIC and the system has become 
stable, you may wish to amend this screen so that there is a selection of people to 
contact depending on the general nature of the help required. 
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Under Information Owner in the Help pull-down menu list is the name of the 
Information Provider for the current item and how to contact them for further 
information about that menu item. 

4.2.4 Setting up Profiles 

Profiles are assigned to users as a means of establishing security of access to 
information. 

When a document is created, a list of profiles is attached that determines which 
users can access it. Up to 36 profiles can be attached to a document. 

For general access to a menu screen, leave the menu security table empty (no 
profiles). 

Users can be given a number of profiles to reflect their responsibilities across the 
organisation. 

Profiles can be "built" into a hierarchy to reflect the structure of your organisation. 
Each profile can have a parent to which it belongs. This organisation - using parent 
profiles - is only to help you in creating different levels. Profiles are mutually 
exclusive. A "high level" profile does not give access to a profile that has a "lower 
level" in the structure. A user can only access a document that has a matching 
profile. 

If the Sales Department has one general manager, three group managers and a 
number of sales personnel within each group, you can create profiles as follows: 

• S-MGT, for the Sales General Manager. 

• S-GRPA, S-GRPB, S-GRPC for Group Managers. 

• S-SALES for General Sales Personnel 

Depending on who you want to have access to the document, you can assign 
appropriate profile keywords. 
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Profile 	Prat le 	Description 
	 !If .Jr 

ADMIN 	 infoCentre Administrator 
AUSTRALIA 	 Unisys Australia 
SILLIEST 	acus 	test profile 
PUBLIC 	 Customer - Public 
SERVICE 	 Customer - Service 
SERVICE-MF SERVICE 	Service - Mainframe 
U-CS 	Australia 	Unisys Custamner Service 
U -HMG 	Australia 	Unisys SAMS 
U -SALES 	Australia 	Unisys Sales Force 
U3 	 U3 Gro 

U3-2228 
U3-4GL 
US-Aseries 
U3 Executive 
U3-Microproduct 
U3-Operations 
U3-UNIX/PC 

U3-2200 	U3 
U3-4GL 	U3 
U3-ASERIES U3 
US-ENEC 
U3-MICRO 	U3 
U3-OPERATIDN U3 
U3-UNIX/PC U3 

Select a profile =ale .ou want 
Then click on the appropriate rrarnanand kutton. 

httwisitallnAWIMIKAlsgopit*Aba*W 
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To Create Profiles 

Initially, you can 

1. Select Profile Maintenance from the Admin pull-down menu; 

A screen like the one below is displayed, which lists the existing profiles. 
Instructions are displayed at the end of the screen. 

Figure 4-8 The Profile Maintenance Screen 

2. Click on the Add button to add a new profile. The Add profile window is 
displayed. 

3.4.Win a 

Profile code ...-- 

Parent Profile .... 

Description —__ 

    

    

Figure 4-9 The Add Profile Window is Displayed 

3. Enter the profile name and the parent profile (if there is one) and a description 
of the profile group. 

4. Press XMIT. 
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4.2.5 Setting up Information Providers 

Information Providers, as part of an InfoGroup, will create documents that can be 
entered to the system. Information Providers are the same as any other user when 
they are accessing information outside their InfoGroup. 

To create Information Providers, simply register them as users. When you create the 
InfoGroup to which they belong you enter their User-ID. Refer to the section on 
Registering a User for detailed instructions. 

4.2.6 Setting up InfoGroups 

InfoGroups are established for three reasons: 

• To help you organise your information sources, e.g. a sales department with 
three product groups should correspond to four InfoGroups. 

• To assign responsibility for the information provided, e.g. each InfoGroup has 
an information owner. 

• To relate menu items to information providers. Generally speaking each menu 
item relates to a corresponding InfoGroup. 

The later point is not always true. You could have a Product Announcements menu 
item that belonged to the Sales InfoGroup as well as a Latest Product Sales Report 
menu item that also belonged to the same group. 

To Create an InfoGroup 

1. 	Select InfoGroup Maintenance from the Admin pull-down menu. A screen like 
the following one is displayed. 

'''""°A614"66**4g14aalla4WWVgPoRIM 

InfoGroup Fix Description 	Code Code Owner 
Pre 	 Urge Cost 	

Dept 

Liner 3 
as 

e in : 	a 
Bulletin BULL Bulletin Area 0505.0884 DEMO 
CALENDAR CALL Calendar 0585.8684 DEMO 371 
CONF 0505.121884 DEMO 371 
Conference 

CON- Conferencingrea  
CONF Conference 0505.0504 DEMO 371 

DEMO DEMO test info group 05155.0810 DEMO 30 g 
DOCUMENTPOOL POOL ADMIN DOCUMENT POOL 0555.0584 DEMO 371 
buide bUlD User Wide Ubbb.168b4 

DEMO HELP HELP Local system help 0000.8000 371 
INDEX 
JOBS 
MAIN 

INDX InfoCentre Index 
JOBS Positions Vacant 
MAIN Main Menu screen 

0505.0804 DMO 
0505.0294 DE

E
NO 

0525.0894 DEMO 

371 4,,? 
371 
371 W %% 

MKTA-COMM9 MCDC Marketing 0505.0284 DEMO 371 
MyManu MyMe My menu screen 2505.EI884 DEMO 971 
News NEWS News E. What's Num 0505.0884  DEMO 	 371 

Select en Intearoup eels want_ 
Than °lick en the. appropriate command button. 

sa. 

EgaMM:SEL re:=ENSI 

Figure 4-10 InfoGroup Maintenance Screen 

NOTE 

A user may own more than one InfoGroup. 
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2. 	Click on the Add button to add a new group. The Add InfoGroup window is 
displayed 

... ... .• 

 

777:77idit, 

 

Info Group-ID ..---.—.--. 	MEM 

Description --.—.—.—.—.—

Owner's User-ID j Dept/ .—.. 

Organization if Ca= Centre _ 

Screen or Document Prefix .. 

Limit of total menu Items ..... 

InfoGroup Admin list ? 

nre7.14",M 	 . 	:104*  

Figure 4-11 New InfoGroup Details 

3. Enter the name and description you want to attach to the InfoGroup. 

4. Enter MAPPER User-ID and department number of owner. Click on User List 
button to get valid User-IDs. 

5. Enter organisation & cost centre numbers for InfoGroup. Click on 
Organisation/Cost button to get valid input codes. 

6. Prefix - attached to front of screen or document numbers. 

7. Limit to total number of menu items (across all menu screens) in the 
InfoGroup. 

8. Add InfoGroup Admin List? - If "y", input screen for up to 36 alternate 
administrators is displayed. 

9. Click on the OK button or press XMIT. 
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In addition to the owner of the InfoGroup, you can assign up to 36 users as 
"assistants", who will also have read and write access to all of the contents of the 
InfoGroup. 

.. . 	. 	. . 	. 	. 

Enter User-icl[s) who will have sane previleges astir brioGroup 
Owner her. 

fogft,-%44  
4,"attrisktattr. 

f77507172171 

Figure 4-12 InfoGroup Administrators 
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4.2.7 Registering Users 

The Registration Process 

The registration process is split into two major functional areas. 

• User registration in EIC 

• Registration of users job accounts then account access to specific applications. 
(see Section 8 for application & account registration). 

Registering Users 

User Registration is achieved in two ways: 

• User Self Registration 

• Administrator Registration 

Self Registration 

While the EIC system expects every user to be registered, it is not intended that an 
administrator must do this for "public" or basic users. 

A self registration capability is provided for "public" users of the system. The public 
user must provide the system with basic information on first calling the EIC system. 

This "public" or base level user has a default profile attached to them. 

	  CINFO/SY - Self Registration 	  

Please enter your personal details as a new user. 
Then press the transmit key to register your User-ID. 

User-ID 	 [DEMO 	] 
Employee number 	 [11 3 
Organisation / Cost Centre . E____3/E 	3 ** See NOTE below 
Your Name 	 [ 	 ] 

Phone number 	 C 	 3 
E-Mail box number 	C 	 3 

** Note: 1. If you don't know your ORGANISATION code, 
tab to the Organisation input field then press F5 (Prompt 

2. If you don't know your COST CENTRE code, 
enter your ORGANISATION and tab to the cost centre 
input field then press F5 (Prompt). 

12Cancel 
1 
	

2 	3Exit 4Refrsh SPrompt 6 	7 	0 	9 	10 

Figure 4-13 Self Registration Screen 

NOTE 

That each user must provide organisation and cost centre numbers. This is 
used for reporting purposes. 
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Administrator Registered Users 

1. 	Select User Registration from the Admin pull-down menu. Select Add, Modify 
Details from the cascading menu. A screen like the one below is displayed, 
listing the existing users. 

Figure 4-14 User Registration Maintenance Screen 

To add a new user, use Add to display a fresh input screen or use Copy to copy an 
existing user's details (the system comes with a "dummy" user set up). If you have 
users from the same department or in similar  roles, copy one to set up the others. 

2. If you want to Copy a user, use the pointer to mark the User-ID that you want 
to copy. 

3. Click on Copy. The user details window is displayed showing the details  that 
you copied. Or click on Add to display a new input screen. 

Figure 4-15 User Details Window 
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4. Change details as required. Make sure that you change the User-ID. 

5. Click on the OK button or press XMIT. 

Once you have recorded the user's details you need to set up the user's profile. The 
user profile (of the record you copied) is displayed. A blank input screen for user 
profile codes is displayed. 

If you are not sure of the profile to be applied clink on Profile list. 

Oft£777=7 
100., 111940$145 . 	............................ 	.... ..." . .. . 

Figure 4-16 User Profiles Window 

6. Enter the profiles required - up to 36. Use the Profile list button to display a 
list of valid profiles and make your selection from the list if required, by 
marking the profile(s) and selecting amend or replace. 

7. Click on the OK button or press XMIT. 
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4.3 Setting Up a Menu Structure 

4.3.1 Managing Menus 

It is recommended that two separate sections be setup in the menu structure within 
EIC. They are the Index Section and the Organisation Section. These sections 
should both contain basically the same information, but differ in the way that 
information is organised, or structured. 

In either of these sections, fast access menus may be set up which provide a quick 
method of accessing frequently referenced information which is stored deep within 
the menu structure. 

4.3.2 The Index Section of the EIC Menus 

The Index Section of EIC structures information according to the subject of the data. 
As changes are made to the InfoGroup database, you should make corresponding 
changes in the index menu. 

Sub-menus within the Index Section of EIC should always be organised purely 
according to the subject of the information, but should only be detailed enough to 
make searching by subject as efficient as possible. 

4.3.3 The Organisation Section of the EIC Menus 

The Organisation Section of EIC should be structured in a way that reflects your 
organisation's structure. The top level of this menu should contain all of the 
independent organisations within your corporation. 

As a System Administrator, you will probably be responsible for the way EIC runs 
for one or more of these organisations. Within each of the organisations for which 
you are responsible, you should set up a menu structure which matches its 
organisational structure. The purpose of structuring this way is so that information 
can be located based upon what part of the company it belongs to. 

4.3.4 How the Two Sections are Related 

In order that no duplication of data occurs, the two sections of the menu must be 
directly related, with no information present in one section absent in the other. This 
is done through a process of double reference. 

What double reference means is that there are two references to every entity within 
the EIC menus. In this context, an entity can be an individual item, such as a single 
document or form, or a collection of items, such as a menu structure containing sub-
menus, documents, applications, etc. 

For each reference which you make to an entity from the index section, you must 
make a reference to the same entity from the organisation section. 
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The way that you divide up all of your information into entities is entirely 
dependant on the way that the structure of the index section can be related to the 
Organisation Section. 

If the way your organisation is structured is similar to the way in which the 
information is structured, then the number of separate entities which must be 
double-referenced will be small. 

If however, the way that your organisation is structured is very different to the way 
in which the information is structured, then the number of separate entities which 
must be double-referenced will be large. 

4.3.5 Fast Access Menus 

Once you have set up the menu structure, people will access information according 
to their individual needs. Often there will be a particular menu, document, or 
application which many people will access frequently. If this frequently accessed 
information is several levels deep inside the menu structure, you can improve the 
useability of EIC by adding fast access menus to the menu structure. You can create 
fast access menus by making a sub-menu which refers to an already existing menu. 

4.3.6 Example Structures 

The following screens show an example structure following the approach just 
outlined. 

.4_10 

Figure 4-17 Main System Screen 



- 	- ',... 	,,.1l3:Abiti1MdAilif-:':' 4  ki. ::aiii- '',. .,...::,.:., ,,..:.;;;;,,..,„......:".4.- 
P 1 CONFERENCE a3aiiierencetr4uiries 
M 2 113-2250 	U3: 2200 User Group 
A 3 U3-4GE 	U31 4GE User Grcup 
M 4 U3-ASERIEB U31 R Series User Group 

'M 5 U3-EXEC 	U3: Executive InFormation Provision Screens 

omung up me system 

Note the following points: 

• U3 user grouping; 

• Go - index to specific information items; 

• Track - access to a specific application; 

• VARS - access to information via value added grouping. 

CINFO/SY !U11121 

Figure 4-18 User Group Index 

CINFD/SYiIIDX1 

Line: 2 

H 2 ADM 	InfoCentre Administrator's Area 
M 3 ANNOUNCE 	Unisys New Product & Press Releases 
M 4 AERIES 	A Series Workbench 	 ,- 

M 5 BULLETIN 	Bulletin Board Areas 
M 6 CALENDAR 	1992 Calendar of Events 
A 7 CALENDAR 	1992 Diary 
M 8 CASE 	CAGE Workbench 
M 9 CONFERENCING Customer To Customer: Conferencing 
M 10 CiDe 	CTO Workbench 
M 11 DIRECTORY 	Unisys Directory 
M 12 EDUCATION 	Customer Education 
M 13 GUIDE 	InfoCantre User's Guide 	 m 
M 14 HOTLINE 	Your Feedback To The infoCentre Adeinistrator 
M 15 JOBS 	Positions Vacant Notices .  It'• 
M 18 ORDERS 	Forns For Placing An Order With Unisys 
M 17 PC 	 PC Workbench 	 F.  
M 18 PRODUCT 	Product Information 
B 19 SALE 	For Sate - Bulletin Area 
m 20 SOFTWARE 	-'14111...63 keS°ftliremTzb:1,,,,mwmvi • 

Figure 4-19 Index to Information Items 
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Figure 4-20 Access to Other Applications 

C1NFO/9Y:VOR91 

      

M 1 RANCUNCE 
R 2 CALENDAR 
M 3 MARKETING 
M 4 PRODUCT 
M 5 SUFWARE 

Unisys keii-Product & Pre Releases 
1992 Diary 
VAR Marketing Bulletins 
Product Infornation 
Rvoilable Software 

.............. 

9 

9 
9 

      

Figure 4-21 Value Added Group Index 
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4.4 Establishing Items on Menu Screens 

There are seven Item types which may be added to an EIC menu screen. 

• another menu, 

• a form, 

• a free-form document, 

• an external application, 

• a summary message area, 

• a Conference area, 

• a Bulletin Board area. 

To enter a new item on a menu screen, go to the File pull-down menu, select New 
Item. An item type selection screen is displayed. 

Figure 4-22 New Item Selection Screen 

If the item is to be an Icon, the icon type may also be selected. The options are: 

System default 	Standard Icons defined by the system for menus, forms etc; 

Customized 	Not available; 

Traffic Right 	Not available. 

4-22 



"" Sort by 

0 Key 
0 Subject 
O ❑ate 
' None 

Ascending 

0 Descending 

items 

SSD 	days 

Display 

0 Creation Date 

O Scrccn-ID 
(5' Non: 

laMPn,Vin 

InfoGroup for the Menu: 

Maximum no. of items: 

Retention period: 

KEL.=ef=1,14 
Update users 

''' Options 	  

❑ 1. Documenin only 
❑ z. Display items created by current user only 

❑ 3. Display as ICONs - DV/ Workstation olny 

Setting Up the System 

4.4.1 Menu - Creating a New Menu Entry 

Select Menu in the New action window. A screen will be presented which solicits 
information about the Menu type to be generated. 

Figure 4-23 New MENU Item Set-Up Screen 

The entry items required are self explanatory. In addition to the InfoGroup owner 
and the administrator, up to four other persons may maintain items to be attached 
to this menu screen. 

Use the InfoGroup List and the User List to select InfoGroups and User-IDs. 

Under Options you can specify if the menu will: 

• contain documents only; 

• only display items created by the user calling the menu; 

• display items as Icon menu or List Box menu. 

NOTE 

The number of menu items nominated for this screen is deducted from the 
allocation setup by the system administrator for the InfoGroup as a whole. A 
warning message will be given when the upper limit is reached. 

When the entry fields are completed, click on the OK button or press TRANSMIT. 
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The next step is to enter details on the Title and security setup screen. 

Figure 4-24 Title and Security Set-Up Screen 

Note that the primary keyword is displayed on the menu screen along with the 
menu entry title. Twenty four other keywords may be entered, these are not 
displayed. 

A summary description may be established to describe the menu entry, this is 
selected by entering 'Y' in the Summary? field. On completion of data entry and 
transmitting, the following input screen is displayed to allow the summary to be set 
up. 

Figure 4-25 Summary Input Screen 
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If access security is required, enter 'Y' in the Access Security? field. On completion of 
data entry and transmitting, the following input screen is displayed to allow the 
necessary role profiles to be entered in the security input screen. 

Use the Profile List button to display a list of valid profiles. 
• •••••,. 

Figure 4-26 Item security Input Screen 

NOTE 

Role profiles entered ACROSS the screen are AND'd Role profiles entered 
DOWN the screen are OR'd. Any combination may be entered to achieve the 
necessary access security. Only those users with the specific role match will be 
allowed access to the menu screen. 
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4.4.2 Form - Creating A New Input Form 

Forms are used to apply for things, or as control documents of some kind. When 
used in conjunction with the mail system, they become a simple but powerful 
mechanism whose functionality may be used by the EIC administrator for many 
different functions. 

In addition to mailing, a Form may also be optionally saved to a nominated menu 
anywhere in EIC. This allows an audit copy of a completed input document to be 
saved. 

The input forms are completely free-format. The descriptive (literal) text is protected 
when displayed for users. Input fields are defined by use of the underscore 
character. The use of MAPPER reserved words adds a powerful capability which 
allows a document to be sent which has the current date or time or an incremental 
sequence number, etc. 

Select Form from the New entry window. A List Box of InfoGroups is displayed. 

Figure 4-27 Define the InfoGroup for the Form 

Select the InfoGroup in which the Form will be registered. 

Enter the Title and keyword details as shown in Figure 4-20. 

The process of entering the New Form is now completed, the menu screen on which 
the new form is attached is displayed. 

To develop the form, select the form entry the user created (as detailed previously 
from the menu) and TRANSMIT to go to the form. 

A blank input form will be displayed. 

Go to the Edit pull-down menu, select Update, then TRANSMIT. 

Enter the necessary text, using the editor commands as required. 
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If the Form is to be saved in an audit trail menu and/or to be sent to the E-Mail 
system, go to the File pull-down and select Title & Options. 

Setup a save area by entering the InfoGroup and menu number in which the form is 
to be saved. If not required, leave blank. 

Enter the Mail details if required. 

When data entry is completed, press TRANSMIT. 

Now go to File pull-down and select Save to store the form. 

4.4.3 Document - Entering a Free-Form Document 

1. Select Document on the New entry window. 

2. Nominate the InfoGroup in which the document will be located. 

3. Enter the Title, Keyword and access security details. 

On initial entry a blank document will be displayed. 

4. Go to the Edit pull-down menu and select UPDATE to update the document. 

5. Use the editor commands to edit the free-form entered text. 

6. On completion of text entry, select Exit on the File pull-down menu. 

7. On the pop-up dialogue box select yes to save the text and return to menu. 

The document is now available to users. 
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4.4.4 Application - Connecting an External Application 

Two major capabilities are provided by APPLICATION connection function. 

• Passing control to an external application. 

In this mode, the EIC system hands control over to the selected application and 
the user is under the control of that application. On exiting, user control 
returns back to EIC. 

• Displaying data generated by an external application. 

In this mode, EIC does not know anything about the external application 
simply displaying data presented by it. This is a core component of the 
Executive Information capability. 

Select Application on the New input window. 

Application call statement: 

Result type to be passed from the application: 

None 

Text 

Mapper Graphics 

As defined In the result heading 

Menu ENTRY POINT of a foreign InfoCentre 

Designer Workbench Application 

Figure 4-28 Application Details Screen 

Enter the Application Call details. (Run name, sub- calls, etc). 

Select the result type to be passed - this determines whether control is passed to the 
application or not. 

If EIC is to pass control to the application select 'none'. 

If EIC is to display data from the application without passing control select the 
appropriate result type definition. 

If the application being called is on a different system to this one, select Foreign 
Media Entry Point. 

Enter Title, keywords and security details in the setup screen. 

Example; 

PRICES,2200.software 
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4.4.5 Summary - Setting Up a Summary Note 

1. Select Summary on the New entry window. 

2. Setup the Title, keywords and security details. 

Figure 4-29 Summary Note Input Screen 

3. Enter the summary note details then click on the OK button or press 
TRANSMIT. 
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4. 	To access the Summary Note, position the pointer to the menu item created 
and 'double click' or press Xmit. 

Figure 4-30 Summary Note Display 

4.4.6 Conference - Setting Up a New Conference Area and Facility 

Select Conference on the New input window. 

Establish the menu screen using the setup entry screen. 

Figure 4-31 Conference Setup Input Screen 
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Enter the details for the Title, keyword and access security setup screen. 

The Conference Area menu screen is now setup. 

Go to the new conference area, a blank menu screen will be displayed. 

CINFO/SY :CON-11 

Figure 4-32 Initial Menu Screen for Conference Area 

The next step is to establish a conference. 

Go to File pull-down and select Open New Conference. 

This will allow the establishment of the initial conference. 

Enter Title and security details as for previous actions. 

Go to the new Conference, a blank input screen will be displayed. The initial text to 
start the conference process will be established in this area. 

To do this, go to Edit and select UPDATE. 

Enter the initial text, using the editor as required. 

To open the conference for use, go to File and select Open Conference. 
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4.4.7 Bulletin - Bulletin Board Establishment 

Select Bulletin Board on the New entry window. This will initially establish a 
Bulletin area. 

Enter the InfoGroup and menu setup data. 

Enter the Title, keyword and security details. 

The Bulletin area is now established. 

Go to the new Bulletin area, a blank menu screen will be displayed, select New on 
the File pull-down menu. 

Figure 4-33 Bulletin Input Screen 

Enter the data in the Bulletin input screen as required, then click on the OK button 
TRANSMIT. 

The person who sets the Bulletin up will see the above screen entry. This will allow 
further updates if required. 
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All other users see the Bulletin as a Pop-up window. 

141.4k, .  
File Edit View liAntiow Help 

CI NFIY5V PO 

Figure 4-34 Example Bulletin Pop-Up 
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4.4.8 Changing Icons 

1. Display the menu to be changed. 

2. Select MARK function on the EDIT pull-down. 

a menu of screen items will be displayed. 

PACE InfoCentre 
View Options Window Admin Help 

Bti 	Info %led 	PROGRAMS 

Figure 4-35 Change Item - Edit Pull-Down 
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PACE Information System 
N 1 Admin 	PACE Administration 
B 2 Bulletin 	Diary Dates / For Sate / Announcements 
N 3 DEMO 	Demonstration Menus 
N 4 Directory 	Telephone Listings 
N 5 60 	Index to PACE Information 
N 6 Groups 	PACE Group Information Areas 
M 7 Info Project InfoCentre Development Related 
N 8 Library 	Library - PACE Library Operations 
14 9 PACE 	Information about PACE 
N 10 Policy 	PACE Policies and Pt-mares 
N 11 PRIMUS 	PRIMUS Services 
M 12 PROGRAMS 	CS Programs 
N 13 Quality 	PACE Quality Program 
M 14 Reporting 	General & CSS Reports 
M 15 Travel 	International & Domestic Travel Bookings 

15-05-92 ADMNI 
15-05-92 BULL1 
04-83-93 CSPR2 
10-84-92 PACO? 
11-69-91 INDX1 
29-05-92 PGRP1 
30-86-92 info! 
11-82-92 LI;"1 
10-83-92 PACOI 
17-09-91 PAPP! 
03-02-92 PAPP2 
07-06-93 CSPR36 
18-09-92 QUIL1 
11-89-91 GREP1 
22-84-92 tray! 

Mark the item(t) you want to select_ 
Then click on the appropriate command button. 

taiTdart,— ,\  W..... 	. 

       

       

Figure 4-36 Select Item to Change 

3. Select the item corresponding to the icon you wish to change. 

4. Select the CHANGE button. 

the Change Menu Item selection screen will be displayed. 

Figure 4-37 Change Menu Item 
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5. Select the CHANGE ICON button. 

an Icon source selection screen is displayed. 

Figure 4-38 Choose Icon Source 

6. Select SYSTEM ICONS. 

an icon Picture Selection menu will be displayed. 
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Figure 4-39 Select Icon Picture 
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7. Select the required Icon. 

the Change Menu Selection screen will be redisplayed. 

Figure 4-40 Return from Icon Selection 

8. Select CANCEL to process the selection, or CHANGE ICON to choose another 
Icon. 
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4.5 	Getting Data into the Structure 

4.5.1 Creating Documents 

You can create a document within EIC in several ways: 

• Create a blank document, then enter the text content; 

• Importing a text file from the host computer; 

• Use the external CREATEDOC capability. 

These three methods are detniled as follows: 

4.5.2 Updating a Blank Document 

To create a document within EIC: 

1. Move through the menus to the menu in which you want the new document 
recorded. 

2. Select the "File - New item" option from the Menu Bar. 

3. If there is no ordering setup for the items on the screen, EIC will display a 
message requesting that you position the cursor at the position on the screen 
where you wish to insert the new menu item. Once you have positioned the 
cursor, press the transmit key. 

4. Specify the type of item you are creating as a document. 

5. Specify the InfoGroup to which this document will belong. 

6. Complete the standard item definition form. which is documented under 
"Establishing items on Menu Screens" in the "Setting Up the System" section of 
this guide. 

Once this process is completed you will have an empty document to which you can 
add text by following the "updating" procedure, which is detailed further on in this 
section. 



Primary Key 	 

Subject 	 

Keywords 	 

N.* 

0 System default 

Select from System Icons 

0 Select from a menu (Enter a menu-Id) .... 

C). Traffic iipt 

80 

Menu Item Informations: 

Icon type: Icon menu only Options: 

❑ Summary Info 

❑ Access Security 

❑ What's New 
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4.5.3 Importing Files 

PC, host or MAPPER files may be imported into EIC and stored as menu items - 
these may be text, binary or MAPPER graphics files. For PC binary files, EIC 
requires that a PC application (for example Microsoft WORD for Windows) must be 
nominated as the mechanisms which EIC will launch to display the file. This 
software must obviously be installed and configured on the User's workstation 
workstation - if not available, EIC displays a message that the file is not displayable 
on the current workstation. 

To import a file as part of the process of creating a document, select the "File -
Import" option in the Menu Bar 

The File Import screen provides the facilities necessary to import and establish a file 
as a menu entry in EIC and to establish the necessary security and access controls. 
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Source: 
	

0 Host 	0 Mapper 

File Name: Full path name for PC / Hostfile or Mapper Report-id (R-D-C). 

Object Gass: File type or ,Noplication associated with. InfoGroup: 
	

Width: 

Figure 4-41 File Import Screen 
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The File Import screen comprises two major functional areas, each detailing the 
information to be provided in establishing a file in the EIC menu structure. 

File type selection area 

Source: 	€ PC 	C..-1 I lost 	0 Mcoper 

Rlo Namo: Ru path na-no fcr DC/ Hoct tilo or Mapper Ropprt-id (R-D-C). 

Figure 4-42 File Type Selection, Associated Application 

This section of the screen allows the target file name to be defined as folows: 

Step 1 - nominate the source file type by checking the respective Source indicator. 

- PC file - use the standard PC file definition nomenclature (example 
C: \EIC \ test. doc). 

- Host file 	- use the standard host file definition nomenclature. 

- MAPPER REPORT - use the standard nomenclature (example 1A20 = Report 
1 Drawer A Cabinet 20) 

Step 2 - If PC file, you must nominate an application which will be loaded to view it 
once it is inserted in EIC. (When the user selects the menu entry, the file is 
downloaded and the viewing application is launched automatically). Otherwise, go 
to step 3. 

Step 3 - Nominate the Infogroup in which this item is to be inserted. 

Note: Leave column width at default (80) for PC files. 
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EIC Menu establishment area 

Menu Item Informations: 

Icon type: Icon menu only 
	

Options: 

❑ Summary Info 

❑ Access Security 

❑ What's New 

Figure 4-43 EIC Menu Item Establishment 

Note: For a full description of this process, refer to Section 4.4 in this 
Administration Guide. 

To complete the menu description, the following must be provided: 

A Primary Keyword. 

Subject heading (menu item description). 

Additional keywords (more may be added by selecting the More Keywords 
button. 

Select the source of the icon to be paired with this file (Icon menu only). 

Options: 

Check the Summary box to attach a summary message to the menu entry. 

Check the Access security box to control access to this item. 

Check the What's New box to have the item added to the News menu 
area. 
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File name: 	airectoriec 
e:‘ 

Drives: 
e: ms-ramdriva 	El 

eicdlstl _dist 
eiccUst2.dat 

Err 

List Files of Type: 
Data file (-.DAT) 	E3 

Figure 4-44 Imported PC File Location Screen 

Enter details of the PC location of the file. 

4.5.4 External Document Interchange and Placement 

The Document Interchange and Placement (DIP) capability will be established on 
each host system used as a document source. This capability is intended to allow 
any MAPPER report to be directed to a target EIC system menu on a nominated 
host or hosts. Where a host system is also to be used as a queuing node for 
documents being sent to other local EIC systems, additional functionality (not visible 
to the user) will be provided to achieve this. 

4.5.5 The Document Interchange and Placement Mechanism 

For the User, the DIP mechanism consists of three major functionality components. 

• the external DIP run which transfers the document to nominated EIC systems. 

• a Distribution List mechanism.  

• A 'spawning menu' capability. 

On selecting a document to be sent to an EIC system, the User accesses the 
document and then calls the 'CREATEDOC' run (note that the run name may vary). 

A selection screen is presented on which the User may nominate a predefined 
distribution list name or the specific EIC system name(s), Information Group and 
menu(s) to which the document is to be directed. This screen also allows the User 
the choice of including the document in the public news area and whether there is to 
be access security constraints attached to the document. 
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PACZ/SY 	 Create PAID Document 

Command 	 12Canoal 
1 	2 	=sit 4Refrah SPrcapt 6 	7 	S 	9 	Motion 

Figure 4-45 Document Interchange Menu 

Enter a distribution list or destination details. A menu confirmation screen is then 
displayed after completion. The DIP mechanism will then place the document on a 
transfer queue and notify the User that the process has been committed. 

If the User does not have the right to send a document direct to anienu screen in a 
EIC system, the incoming document will be trapped in a system 'pool' menu for 
authorisation and final placement by the system Administrator. 
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4.5.6 Distribution List Establishment 

A distribution list is established by the EIC Administrator in order to have a 
standard set of destinations for particular document types. The Distribution List 
information is copied to the Document Interchange and Placement Directories on 
each host where documents may be dispatched to an EIC system. 

To establish a distribution list, select System tables on the Admin pull-down menu. 

On the System Tables cascading menu select the Distribution List entry. 

rtn 	Edi 3trrow Mai or a Wridirtt  	  

COM/SY:MIN( 	SYcteal  Mee D3ge••• 

GU= 	WOENTREELE,CCROlf  Ad 25  
ercefile hAzistrazare 
IIITSETI316P Ittantrtartte 

User Rraisitation 

System ;loons 

&Pints 
ilecuracnt Peal 
%waft 821;ket 

pawriing Meru 
Etomete them 

Admin Contact Into 

Goat centre 
OruazIzeon 

Figure 4-46 System Tables Menu on Admin Pull-down 

Step 1 

Figure 4-47 Dip Distribution List Maintenance Menu 
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Distribution List name 	  DECIN 
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Seq List name 
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Step 2 

To add a new Distribution List, select the Add button. An input screen will be 
provided which solicits the following information. 

• the Distribution List name; 

• the InfoGroup it will belong to; 

• a descriptive title for the Distribution List. 

Enter the necessary details then click on the OK button or TRANSMIT. 

IGIC/Sr 
	

Distribution list 	 Ln: 1 of 1 
rile Help 

Communal 	 12Cancel 
1 	2 	3rocit 4Aefrsh 5Prompt 6 	7 	 9 	10 

Figure 4-48 DIP Distribution List Input Screen 
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Step 3 

The system now redisplays the list of distribution list names with the one just added 
highlighted. Select the Destinations button to add destinations to the list. 

Figure 4-49 DIP Destination Maintenance Screen 

Initially the destinations for a new distribution list will be empty, select the Add 
button to add destinations. 

08,0 
Ettar 

71: 

Figure 4-50 DIP Add Destination Screen 

Select the destination system from the list box, enter the destination InfoGroup and 
Menu ID. The Administrator may optionally have all documents displayed on the 
target system News screen and also establish access security parameters. Transmit 
or click on the OK button. 

Use the Add function to add as many destination systems as required. 
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Step 4 

When all of the target system entries are completed, select the Go Back button to 
return to the Distribution List maintenance screen. 

Figure 4-51 DIP Distribution List Maintenance Screen - Example 

Step 5 

The new Distribution List is established and at this stage the DIP directories are 
updated. The Administrator may now exit back to the system. 

4.5.7 Spawning Menus 

The Spawning Menu capability allows a regional information manager to have 
documents sent to nominated menus, automatically 'spawned' to other menu screens 
on other EIC systems in the region. 

As an example, a Product Manager in SPG in directing documents to the local 
InfoCentre system (using the EIC Application) would have them automatically 
distributed to the Customer InfoCentre systems (UNIX-based) in Australia and New 
Zealand. 

Note that the 'spawning' capability is only utilized by the Document Interchange 
and Placement (DIP) mechanism. 

Any EIC system menu may be established as a spawning menu. 
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Step 

Select the System Tables entry on the Admin pull-down menu and nominate 
Spawning Menus. A Spawning Menus maintenance screen is displayed. 

In the example, no menus have been established. 

Figure 4-52 Spawning Menus Maintenance Screen 

Step 2 

Select the Add button to add a new Spawning Menu. 

The system will provide a pop-up window which allows the nominated menu to be 
defined. 

Figure 4-53 Nominating a Spawning Menu 
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Step 3 

Enter the required menu ID then click on the OK button or TRANSMIT. 

The system now redisplays the list of spawning menus with the one just added 
highlighted. Select the Destinations button to add destinations to the menu. 

Figure 4-54 Spawning Target System details 

Initially the destinations for a new spawning menu will be empty, select the Add 
button to add destinations. 

id tt It it 
	 ,01 

Figure 4-55 Spawning Menus - Add Destination System Details 

Select the destination system from the list box, enter the destination InfoGroup and 
menu ID. The Administrator may optionally have all documents displayed on the 
target system News screen and also establish access security parameters. Click on 
the OK button or Transmit. 
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Step 4 

Having entered the target EIC system details and nominated security provisions are 
required in this instance, on transmitting a Security Access maintenance screen will 
be displayed. 

Figure 4-56 Target System Security Details 

Enter the EIC Access Profiles allowed to have access to the target menu screens 
then TRANSMIT. 
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Step 5 

The destinations for the spawning menu are displayed. 

Figure 4-57 Target System Maintenance Screen 
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Step 6 

Select Add to add more destinations or Go Back to return to the spawning menus 
maintenance screen. 

This will now display the new Spawning Menu entry. 

Figure 4-58 Example Spawning Maintenance Screen 

The Administrator may now return to normal EIC system operations. 

4.5.8 Document Interchange and Placement - System Overview 

The Document Interchange and Placement mechanism is an external mapper 
system which is used to transfer a MAPPER report to any number of target EIC 
systems by individual system selection or nominated Distribution List. 

Each DIP host has a current copy of the EIC DIP System Directory which identifies 
the available EIC host MAPPER systems and the DIP node from which they are 
queued. 

Within a region, one of the EIC system hosts will be nominated as a queuing node 
for the systems around it. 

'Trusted' Information Providers are allowed to send documents direct to nominated 
EIC system screens without Administrator intervention. 

'Non-trusted' Information Providers may not do this - the documents they create and 
send to a nominated EIC system, are trapped in the document pool for that system 
for inspection prior to placement by the system Administrator. 
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In the event of errors such as the Information Provider not being recognised on the 
target EIC system, menu screen number invalid, etc., the document is trapped in the 
EIC system pool menu. The Administrator can examine the control information 
attached to the document in order to track down the originating system and 
Information Provider. 

4.5.9 DIP System Tables and Components 

The system tables and components that make up or are used to manage the DIP 
mechanism are as follows: 

1. DIP System Directory (Network EIC Configuration tables). 

2. System registration table. 

3. Remote User table. 

4. Spawning menus. 

5. DIP Distribution Lists. 

6. DIP Queue. 

7. EIC Document Pool. 

8. MAPPER run and user registration for DIP. 

9. Network Configuration Report. 
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4.5.10 DIP System Tables Summary 

1. DIP System Directory (Network EIC Configuration Table) 

This table shows the DIP node queuing systems and the EIC systems directly 
associated with them. 

2. System Registration Table 

This table describes the information that the DIP mechanism needs to know 
about the location of the database for each EIC systems on local host. 

3. Remote User Table 

For each remote host identified in this table, a relationship is defined between 
the Information Provider's MAPPER User-ID used on that remote host and the 
same Information Provider's MAPPER User-ID on the target MC system. 

The DIP mechanism passes the Remote User-ID, Remote MAPPER 
Department number with the transferred document. 

A number of default options are available with this table by leaving the Remote 
User-ID, Remote Department Number and/or Local User-ID fields blank. 

.@ 	Remote MEDIA Users 
* Remote 	Remote 	Rmte Local 	Loc 
* Host-ID 	User-ID Dept User-Id 	Dept *.-----------.  	 .====..10========.====.=============== 

MAP1SN 	 641 
MAP2SM 	DEMO 	641 
MAP5SN 
MK 

END REPORT 

1 	2Paint 3 	4Return 5 	6Tasks ?View 6Help 

Figure 4-59 Remote User's Table 

Example for the table shown: 

If Remote User-ID is left blank, anyone in Dept 641 can send documents direct 
to a menu on the target EIC system. 

If the Local User-ID is left blank, the Remote User-ID is used on the target EIC 
system. 
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4. Spawning Menus 
This table shows the nominated Spawning menu with the 'slave menus' 
attached. 

The information for each 'slave' menu includes the InfoGroup and system 
name. 

This facility in effect provides a distribution list attached to a nominated menu 
in the local EIC system. 

Identification of an existing menu as a spawning menu and maintenance of the 
'slave' or target system menu lists, is done by using the functionality available 
in the System Tables area of the File pull-down menu. 

5. DIP Distribution List 

This table shows the originating system and copy-to system details for each 
DIP Distribution List defined. 

6. DIP Distribution Queue Index Table 
This table describes the queue index structure for the DIP node queue (one per 
nominated queuing host). 

7. Document Pool 

The document pool is a standard EIC menu which is restricted purely for 
Administrator and system use. The main functional exception is that this 
special menu is accessed via the Admin pull-down menu as an Administrator 
function. 

8. Mapper Run and User Registration 

The standard run name used for the DIP application is CREATEDOCBG. The 
standard Application User-ID is BPORT641 

9. Network Configuration Report 

This is a table of MAPPER system and network path names established and 
maintained by the local IS MAPPER co-ordinators. 
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4.5.11 Remote EIC User Registration 

Authorised users may send MAPPER reports or documents from remote hosts to the.  
local EIC information system by calling a special run on the remote host which 
communicates with the Document Interchange and Placement mechanism. 

Users must be registered for use of this mechanism, this is achieved by using the 
Remote EIC Users control table mechanism. 

Register a user on the Remote Users table. 

Select System Tables entry on the Admin pull-down menu and nominate Remote 
users. The existing details are displayed. 

.. 	... 	.. 	. 	..... 	:,.... 
PemOfe 	emote 	flaiiiii 	rocM 1 ** 	1.:Ocit-  * 
Host -Id 	User-Id 	Dept 	User-Id 	Dept 

WiD1-5}47--- 
	NTIMITTITIT,RIT/T.TIT 	 

MAP25M 	DEMO 	541 
MFIP5SN 

Select a Remote User you want. 
Then click on the appropriate command button. 

Figure 4-60 Remote Users Maintenance Screen 
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User-ID remoteuser localuser 

Dept. No. 1641  301 

Remote Host-ID: 

IMAP2S14 

ff-A...::i7.a  
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Click on the Add button to add a new user. 

An input screen for user details is displayed. 

entot .  • .••• •e•• 	c••• 	••,.• ••••• 	•:•• ,•• 

Figure 4-61 Remote User's Details Screen 

Select the Remote Host from the list box and enter the remote and local user-ids 
and department numbers. When complete Xmit or click on the OK button. 

The updated table is redisplayed. Add additional users as required or use exit to 
return to the menu. 

A C*7 
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4.6 	Loading Documents After the System Has 
Been Set Up 
Once the organisation structure and InfoGroups have been setup, you can start 
structuring the menus, setting up forms, importing documents, etc. 

A number of strategies may be adopted for loading documents into a new menu 
system. The most practical approach is to train clerical staff to gather, classify, then 
import the documents into the defined areas. 

The administrator is then left to finally classify, position or discard documents as 
required. 
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4.6.1 Create an "INDEX" Menu 

1. 	Select New Item from the File pull-down menu. 

Figure 4-63 New Menu Item Selection 

2. Select menu. 

3. Click on the OK button or press XMIT. 

You can follow this procedure. for creating other menus. Remember that the menu 
you create is listed on your current screen. That is, if you wanted to create another 
menu within a menu called Index, you would select Index to make it current 
(initially it is blank) and follow the same procedure. 

Figure 4-64 New Menu Item Definition Screen 

4. Create other Menus as desired. 
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4.6.2 Load Documents Into Index Area 

Utilize the EIC import capabilities or the external "CREATEDOC' run to push the 
documents to the nominated screen. 

4.6.3 Creating a Menu Structure 

Careful consideration should be given to the menu screen structure. Try to keep the 
main menu screen as short and uncluttered as possible. With due consideration to 
security, setup an index screen off the main menu which points to each of the 
following: 

• A menu which points to all InfoGroups within the system. 

• A menu which points to InfoGroups belonging to departments within your 
organisation. 

• A menu which points to every MAPPER application available to your users. 

If you have a software development group that contains three project groups, you 
might need to create a similarly  structured menu hierarchy for general information. 

However, each group is interested in security aspects, so a separate menu item 
should probably be set up for security. 

4.6.4 Copying Documents from Index to Relevant Menus 

For each document you want to copy: 

1. Display a menu which contains documents you want to copy. 

2. Select Mark on the Edit pull-down menu. 

3. Mark the document(s) required. 

4. Click on the OK button or TRANSMIT. 

5. Display the menu which will receive the documents. 

6. Select Copy from Edit pull-down menu. 

You can use a similar procedure to move documents (select Move instead of Copy). 

Important Concept 

When you copy an item from one menu to another, the item itself is not 
duplicated. A reference point is set up so that it can be accessed from the new 
menu. 

An item may be "copied" to more than one additional menu. 

A_Rn 
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4.6.5 Copying Documents into Personal Menus 

For important users there may be a requirement to copy documents or setup initial 
links to other menus. 

Use the general procedure described above. 

4.7 Managing InfoGroups 
InfoGroups are separate areas of information. You should assign each InfoGroup an 
owner, who is responsible for all of the information within the InfoGroup. The owner 
of an InfoGroup has read and write access to all information within the InfoGroup. 

In addition to the owner of the InfoGroup, you can assign up to 36 users as 
"assistants", who will also have read and write access to all of the contents of the 
InfoGroup. 

The InfoGroups that you set up should reflect the different subjects that information 
can be grouped by in your organisation. The number of InfoGroups that you set up 
should be determined by the number of groups of people who can be responsible for 
the contents of each InfoGroup. 

As you enter each InfoGroup into the system, you should make a corresponding 
menu in the main EIC index. (See "Menus" below for details) 
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4.8 Updating Documents 

Documents in EIC are edited through a process called updating. Updating is a 
specific mode within EIC. Some different options appear in the Menu Bar when EIC 
is in update mode. 

Before displaying the document to be updated. 

You can enter the update mode by selecting the update action on the Edit pull-down 
menu. 

The way that you update a document can be broken up into 3 stages: 

1. 	Start updating 

Before displaying the document to be updated check if the update flag is set -
look at Update on the Edit pull-down menu. If it is not flagged by a check mark 
set it by moving the pointer to Update and click once. 

Mork 
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Figure 4-65 Setting the Update Flag 

You may now display the document. EIC then copies the document to your 
workstation and displays it - so that any changes are made to the copy which 
you may then save or discard. 
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2. 	Editing the text. 

You can edit the text on the screen by using the various editing keys and 
typing text directly on to the document. EIC will make changes only to the copy 
of the document. 

The commands for editing text are under the Edit pull-down menu. 

Undo 

Cut 

Copy 

Paste 

Delete 

Select All 

Use the pointer to mark text by placing the pointer a the required starting 
point, hold down the mouse button and drag the pointer to mark all the text 
required. 

Use the View pull-down menu to set a default Tab insertion, or to set a flag for 
word wrap . Use the Search pull-down menu to find text or go to specific lines. 

3 	Saving the changed document. 

After amending the document select Exit on the File pull-down menu A pop-up 
dialogue box will ask if the changes are to be saved . Click on Yes to save the 
changes. In this case the original document will be erased and replaced with 
the document on your workstation. 

4 	Discarding the changed document. 

To discard the changed document select No on the ' Save changes' dialogue box 
when you Exit the document. If you choose to discard it, EIC will only discard 
the document copied on your workstation. The original document will remain 
unchanged. 

4.9 Forms 

4.9.1 Using Forms 

Forms are templates which let you mail text information in a standard format. To 
use a form, you should first display the form onto the screen. This will enable you to 
enter data into the pre-defined fields. When the form is ready to be sent, enter the 
command "MAIL" or select the EXPORT option from the Menu Bar. Enter the 
details of where and how the document is to be sent. 

4.9.2 Creating Forms 

To create a form you must: 

• Create a blank form; 

• Start updating the form; 
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• Complete the form specification for data fields, literal text, and special 
keywords; 

• Set up the form Title & Options; 

• Save the form. 

4.9.3 Creating a Blank Form 

The first step in creating a form is to move through the EIC menus to the menu in 
which you want to put your new form. Select the "File - New Item" option from the 
Menu Bar. Select from as the type of the item you wish to create. EIC will then ask 
you to select the InfoGroup that the form will belong to. After that, a screen will be 
displayed where you define how your form will appear within the menu structure of 
EIC. You can find more information on creating a form in the Administrator's 
Reference Manual under "Establishing Items on Menu Screens". 

4.9.4 Starting to Update the Form 

Select the form that you just created so that you can see it on the screen. Start the 
update process by selecting the "Edit - Update" option from the Menu Bar. 

4.9.5 Completing the Form Specification 

When you update the form, you will be defining how it will appear when it is used as 
a template for entering data. Note that when finally presented to the user, the text 
on the form will be protected. Changes are only allowed in the input fields. There 
are two steps in creating a form: 

Defining the Form Layout - Establishing the data entry fields and entering the 
descriptive (literal) text. 

Setting Up the Form Title and Options - This includes establishing the mail list and 
InfoGroup details. 

Defining the Form Layout 

• You can define data entry fields by using underline characters. The data entry 
fields will always hold alphanumeric information. 

You can use literal text to create the field names and any other static text 
information for the form. Literal text will appear exactly the same on the form 
when it is used for data entry as it appears when the form is defined. 

• Entering MAPPER & EIC reserved words. 

The reserved words that you enter will be translated into actual values when 
the form is used for data entry. 

The only EIC reserved word used for form generation is SEQUENCE$, which is 
the sequence number of the document. The sequence number is generated by 
EIC when the document is saved in its predefined menu. 

The MAPPER reserved words you can use in form generation are: 

USER$, The name of the user who entered data into the form 
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DATEO$, The current date in YYMMDD format 

DATEl$, The current date in YYMMDD format 

DATE2$, The current date in DD MMM YY format 

DATE3$, The current date in YDAY format 

DATE4$, The current date in YYDAY format 

DATE5$, The current date in DDMMYY format 

DATE6$, The current date in MM/DD/YY format 

DATE7$, The current date in MONTH DD,YYYY format 

DAY$, The day of the week of the current date 

STNUM$, The station number where the form is entered. 

TIMES, The time that the form had data entered into it. 

ITYPE$, The terminal type of the terminal on which the form was entered. 

4.9.6 Setting up the Form Title and Options 

Select the "File - Title & Options" option from the Menu Bar to begin the process. 
EIC will display a data entry form which lets you specify the title and options for the 
form. This form lets you specify how the generated data will be sent via electronic 
mail, and where it will be stored (if at all). 

The generated data is the document which is generated when the form is actually 
used. The data will include an automatically generated keyword, which will replace 
the reserved word SEQUENCE$, if it is specified within the form. 

The fields in the data entry form are: 

• The form title, which is displayed in the menu containing the form. This is the 
only field which relates to the form itself. All the other fields relate to the 
generated data. 

• What InfoGroup the generated data entered will belong to. If the data is to be 
mailed but not saved, then you should leave this field blank. 

• What menu the generated data should appear in. If the data is to be mailed but 
not saved, then you should leave this field blank. 

• Whether mailing details should be specified by the user after they have entered 
data, into a form. If you enter "Y" for this field, the user data entry form is by-
passed, and the default values will be used to specify where the generated data 
will be mailed to. If you enter "N", the user will be presented with the default 
values, which they can modify as necessary. The default values are the defaults 
for where the generated data should be mailed to. 

• The subject of the generated data. This consists of a single line of text which 
should describe the general content of the data to the people who will receive 
the data. 

• Whether the generated data should be sent as priority mail. 
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• The mailbox and directory ID of the person to whom the mail will be sent. The 
same mail will be sent to several other people by entering their details in the 
fields below the first mailbox field. 

• The mailbox and directory ID of the person to whom a copy of the mail will be 
sent. The same mail copy will be sent to several other people by entering their 
deteils in the fields below the first mailbox field for copy. 

• The MAPPER mailing list name which will be used to define the people to 
whom the mail should be sent. 

• The MAPPER mailing list name which will be used to define the people to 
whom the mail copy should be sent. 

4.10 Document Ageing 
To manage the growing amount of information in an EIC system, you can assign any 
EIC menu a default lifetime. This lifetime applies only to the documents, conference 
& bulletin board messages within a menu. When the age of a document exceeds the 
lifetime specified by the menu in which it exists, that information is placed in a 
wastebasket area for the InfoGroup to which it belongs. It is then the responsibility 
of the InfoGroup owner to determine if the data should be retained or erased. 

The documents stay in the wastebasket area for a further 60 days before being 
purged by the system. 

Access to the Wastebasket Menu is obtained via the Admin pull-down menu. 

The InfoGroup owner or System Administrator may reinstate a document at any 
time by using the Mark and. Reinstate functions. (Reinstate is a function available 
on the Edit pull-down menu). 

A Management report is available for the System Administrator to maintain an 
overall view of Ageing activity. 

Menu items excluded from ageing are: 

Menu, Bulletin Board and Conference menus; 

Open conference items; 

Applications; 

Forms. 

4.11 Wastebasket 
The Wastebasket is a special menu accessible by the InfoGroup owner(s) and the 
system Administrator. 

The EIC system uses the Wastebasket for two purposes: 

• as a temporary repository for documents which have been aged off menu 
screens; 
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• as a temporary repository for ANY menu items deleted during maintenance 
activities. 

Items in the Wastebasket are aged out of the system totally after (typically) 60 days 
- this ageing time is set by system parameter. 

Functionality is provided to allow an Administrator or InfoGroup owner(s) to easily 
re-instate an item back to its original menu along with links to the item from all 
other menus. 

To re-instate or delete item(s) from the Wastebasket command select Wastebasket on 
the Admin pull-down menu. 

InfoGroup-Id Description 
	

Owner 

BILLTEST 	test info group 	DEMO 
BOARD 	Bulletin Board 	DEMO 
BULLETIN 	Bulletin Area 	DEMO 	e• 
CALENDAR 	Calendar 	DEMO 
CONF 	Conferencing 	DEMO 
CONFERENCE Conference Area 	DEMO 
DEMO 	test info group 	DEMO 
DOCUMENTPOOL ADMIN DOCUMENT POOL DEMO 
GUIDE 	User Guide 	DEMO 

l'4W456515024546M%*.algiebi tk,...,..a.z......,.,90.0... 	- • ...a......,..4....4.0... • • 	. 	• 

hOMPAAM. rfrx**1 

Figure 4-66 Wastebasket InfoGroup Selection 

• Select an InfoGroup. 

The items in the Wastebasket for the selected InfoGroup are displayed. 

• Select Reinstate/Delete action on the Edit pull-down menu. 

ws'Ac 
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Figure 4-67 Mark the Items to Reinstate or Delete 

• Select the Reinstate button to reinstate the item(s). 

• Select the delete button to delete the item(s). 

EIC will completely reinstate the item or delete it from Wastebasket. 

4-68 



System Maintenance 

Section 5 

System Maintenance 

5.1 	Copying Documents and Other Items 
Between Menus 
To copy a menu item or document to another menu. 

On 'Copy From' screen: 

• Select Mark on the Edit pull-down menu. 

• Move the pointer to the menu or document entry to be copied. Mark item(s) to 
be copied, then click on the Copy button. 

• Go to 'Copy To' screen. 

• Select Paste in Edit pull-down menu. 

The menu entry or document will now be available on the current screen. 

NOTE 

Documents can have high security in one menu and lower security in another. 
The menu security can be used to control access to the contents of the menu. 

5.2 	Moving Documents and Other Items 
To move a menu item or document to another menu. 

On 'Move From' screen: 

• Select Mark on the Edit pull-down menu. 

• Move the pointer to the menu or document entry to be copied. Mark item(s) to 
be copied, then click on the Move button. 

• Go to 'Move To' screen. 

• Select Paste in Edit pull-down menu. 

The menu entry or document will now be available on the current screen. 
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5.3 	Changing All or a Major Part of the Structure 

In restructuring major portions of the system, a good strategy to follow is to 
establish a temporary menu screen or screens. 

• Move all menu items (and therefore underlying tree structures) to the 
temporary menu screens. 

• Move all isolated documents or items such as conferences to the temporary 
menu screens. 

• Restructure the system menus as appropriate. 

• Replace the saved items in the new structure. 

5.4 Deleting Profiles 

Profiles may be added or deleted as required, but be careful; if you delete parent 
profiles the siblings still exist. 

Use Profile maintenance on the Admin pull-down menu. A screen with current 
profiles is displayed. Select Add, Change or Delete to perform the required task. 
Refer to 'Setting up Profiles' in the 'Setting up the System' section of this guide for 
more details on profile maintenance. 

5.5 Date Formats 

Date formats may be changed by selecting System Options entry on the Admin pull-
down menu. 

Select Date Format. A cascading menu of Date Formats is displayed. Select the 
date format required. 

File Edit ''''''' 
 ♦
''''' gra. Wind  war 	 Help 

Figure 5-1 Date Format Selection 
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5.6 Language 
Language may be changed so that screens, messages etc will be displayed in a 
different language. Language may be changed by selecting System Options entry on 
the Admin pull-down menu. Select Language - a cascading menu of languages is 
displayed. Select the required language. 

Figure 6-2 Language Selection 

5.7 	Display Account User Only 
For example, monthly sales reports can be put into a Sales Report menu. Get your 
MAPPER co-ordinator to load the documents so each has its subject salesperson as 
the creator. Only that person will be able to access his or her individual report. 

5.8 	Changing Cost Codes 
e.g. a department closes down. 

• List all users. 

• Change their cost codes. 
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5.9 	Someone Else's View - Act As 
Whenever an administrator establishes or changes a user's access rights or needs to 
confirm that established security is correct, it is necessary to check that what has 
been done is correct. 

To achieve this, an administrator may 'act as' any other user for which they have 
responsibility. 

Select Act As on the Admin pull-down menu. 

DEMO 	30 DEMONSTRATION 
DUMMY$ 	0 SELF REGISTRATION 
DUMMY$0042 	0 SELF REG FOR 0042 
DUMMY$0505 	0 SELF REG FOR 0505 
GRULA 	42 CARL GRULA 
HUERLIMANN 	12 BRUNO HUERLIMANN 
HUMPHRIES 	1 DEBBIE HUMPHRIES 
JINLEE 	20 JIN Y. LEE 
JINLEE 	30 JINLEE k. k..4% 
LUZADDER 	42 BEY LUZADDER 
OWSLEY 	42 BEY 	 ki4 
PURNELL 	20 KIM PURNELL 

Figure 5-3 'Act As' Another User 

From the List box of User-IDs select the User-ID required. 

5.10 Changing Job Profiles, e.g. Reorganisation 
• Print all users with profiles that are to be changed; 

• Change their profiles; 

• List all screens with old profiles; 

Change them. 

5.11 Changing Information Owner, e.g. Someone 
Leaves 

List all for his/her InfoGroup; 

• Change name; 

• Check InfoGroup members as well. 
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5.12 Changing Screen Attributes 
Move to the menu, document or bulletin whose attributes require change, eg; add 
User-ID for menu maintenance. 

Go to the File pull-down menu and select Title & Options. 

Make the necessary changes then click on the OK button or TRANSMIT. 

Access security may also be changed via the File pull-down menu. 

5.13 System Message 
This facility can be used to send a system message to all users. 

Select System Message from the Admin pull-down menu. An input screen is 
displayed. 

. 	.......................................... 

Paitititit'Ati-tkila0Ve $4101lira& 

Prirk771 

    

    

    

    

Figure 5-4 System Message Screen 

Enter or update text as required (up to 13 lines) 

When finished select the OK button or press Xmit. 

The message will be available to users under the News action on the Window pull-
down menu. It will be displayed as a pop-up message box. 

Use the Remove button to remove a system message. 
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CINFO/SY:POOL1 

System Maintenance 

5.14 Document Pool 

Document Pool is a menu set up to catch documents coming into the system which 
are directed at menus which do not exist, or are sent by users who do not have 
appropriate access security. Such documents may have been sent from other or 
remote systems by the Createdoc function. 

The Administrator can look at what has been captured in the document pool area 
and decide which menu to copy it to or perhaps to delete the item. 

To access the document pool select Document Pool on the Admin pull-down menu. 
The document pool menu looks like any other menu. 

Figure 5-5 Document Pool Menu 

Use the move, copy and delete functions to relocate the items in the document pool 
to the appropriate menus. 
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Account & Application Registration 

Section 6 

Account & Application Registration 

6.1 	Account and Application Registration 

ACCOUNT 
REGISTRATION 

MAIN MENU 

ACCOUNT USER 

DEFINE 
ACCOUNT 

V 

TIE TO 
APPLICATION 

V 

SELECT 
APPLICATION 

FUNCTIONALITY 

SELECT 
MEDIA USER 

TIE TO 
ACCOUNT 

Figure 6-1 Account & Application Registration 

This process is necessary where access control must be established to specific 
applications on an account by account basis. An example of this requirement is 
where the EIC application is utilised as a bulletin board system with user 
entitlement being subject to contract. 
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A 1 BOOR HHS 	Booking System 
K 2 IMPARTMENTS Unisys Australia Departments on AMIC 
K 3 GO 	 Index of items in AMIC 
K 4 GRAPHICS 	Mapper Graphics 

USZR - User Registration 	  

Position the cursor at the function yon want. 
Then press the transmit key. 

• ̂̂ to return) 
2SM 

❑ Add, Delete or Change User Information 
❑ Maintain User account and Applications 

Bottom 

Account & Application Registration 

Establishing a New Account and Application 

This is done in four separate steps and is variable dependent on the specific 
registration requirements of the application being established. 

These steps are: 

• Define the Account. 

• Tie the Account to the Application. 

• Tie a User to the Account. 

• Tie the User to the Application(s) within the Account. 

6.1.1 Accessing the Account Registration Module 

Select User Registration on the Admin pull-down menu. Then on the User 
Registration pop-up, select Maintain User Account and Applications. 

RIC/SY:MAIM. 	AMIC: Australia= Marketing Information Centre 	La: 1 of 12 
Pile Zdit View Options Admin Help 	 16:06:08 

Command ❑user 	 12C.ancel 
1 	2 	Slxit 4Refrah 5 	6 	7 	8 	9 	10 

Figure 6-2 Registration Selection Pop-up 
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Account & Application Registration 

The main menu of the AccountJApplication registration module will now be 
displayed. 

'IC/SY:NUN 	MAINTAIN USER ACCOUNT AND APPLICATION AWN MENU 
rim WEN HELP 	 16:57:55 

         

Remove User 	: Transmit at Account9 
Rag New User : Transmit at User-ID (Past path: Inter Ace #) 	More ; + 
Mtn User In App: Transmit at User-ID (Past path: Enter App) 
Mtn Account 	: Press YES (Past path: Inter •PES,Anc9(,App)• in command line) 

User-ID 	User Name 	 org CCC Account Application 

 

JODI 	- Igtedar Abdi 	0505 0510 testi 
ABM 	- Mike Abel 	 0505 0692 testa 
ABANNETHY 	- Sandra Abernathy 	0505 0702 
ADAMS 	- David Adana 	0505 0005 
=MIN 	- System Administrator 0505 0810 
AlIAT 	 - Laura Affat 	0505 0033 
ALEX 	- Alex Stevenson 	0505 0910 TES22 
ANDENSON2 	- John Anderson 	0505 0312 
ANTHONY 	- Barbara Anthony 	0505 0720 
MAMMON 	- Tricia Atkinson 	0505 0611 

   

Mare.. 
Command ❑ 	 12Cancel 
1Help 2 	Uxit 4Refrsh SlintAcc Mask 7 	Ared 	9 	10Action 

Figure 6-3 Account & Application Registration - Main Menu 

Each user registered in EIC will be listed in this module. 

For each user, note the following details: 

• User ID - Mapper User-ID of the user. 

• User Name 

• Organisation number 

• Cost Centre number 

Account name to which User is tied 

Note the following functionality: 

An input field adjacent to the User-ID allows access for tying the User-ID to an 
account. 

An input field adjacent to the Account field is used in the User-ID removal process. 

An input field for Application name is used in tying account to application. 

Function Key 5 (F5) is used for Account maintenance. 
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Account Detail : Press Transmit at Account =try 
Remove Account : Press Transmit under Rmv 
Regis 	  NNW ACCOUNT 	 

More : + 

I Later New Account Data and press Transmit to register 
A/C II 	  

Identity Name 	 Start fad Review 
ITZST001 3 [Documentation Test 7 [920201] [920202] [9202023 

3 
	

I I 	3 I 	3 I 	3 
3 
	

3 I 	3 I 	3 1 	3 
3 
	

3 I 	3 I 	3 1 	3 
3 I 	3 I 	3 1 	3 

I 
	

3 I 	3 1 	3 1 	3 

	ISQ 
oa11101 

ADVANI02 
CATRAI03 
CITICIO4 
DASACIOS 
FordaI06 
jowl I 	 
JallAINata : Date should be in format YYMMDD 
JUl/PI 	  
=ea 	- Mt Isa Mines 	911001 921231 920131 911001 911001 
nswattge - NSW Attorney General 911002 921231 920131 911002 911002 

Account & Application Registration 

6.1.2 Defining a New Account 

Select Function Key 5 (F5) on main menu to access the Account list. 

NIC/SY:MTNACC 	MAINTAIN ACCOUNT 
RILL 	ULF 10:30:31 

Account Detail 	: Press Transmit at Account =try 
Remove Account 	: Press Transmit under Rmv 	 More : + 
Register Account : Press 16 

Last 
A/C ID 	Name Start Lnd Review Create Update Rmv 

os1100 	- profile os1100 911031 921231 921020 911108 911108 
ADVANCZ 	- Advance Bank 911002 921231 920131 911002 911002 
CATHAY 	- CATHAY 911018 911130 911130 911018 911018 
CITICORP - Citibank 911001 921231 920131 911001 911001 
DASACT 	- Dept Admin Selo ACT 911001 921231 920131 911001 911001 
Vordaust - Ford Australia 911001 921231 920131 911001 911001 
jowl 	- jow test 911101 911231 911215 911107 911107 
Jul/Ana 	- From Julian 901201 921201 921201 911203 911203 
Jul/Pace - Prom JUlian 901201 921201 921201 911203 911203 
=Glee 	- Mt Isa Mines 911001 921231 920131 911001 911001 
nswattge - NSW' Attorney General 911002 921231 920131 911002 911002 

More.. 
Command 0 	 12Cancel 
1Help 2 	3Lacit <Marsh SCopy 6AddAoc 7 	8Fwd 	Main 10 

Figure 6-4 The Account List 

Account details may be copied from an existing Account by moving the cursor to the 
desired account name then selecting Function Key 5 (F5). 

To add a new account, select Function Key 6 (F6). 

The New Account entry pop-up will be displayed. Details for up to 6 new accounts 
may be entered at this time. Once necessary fields are completed, transmit to save 
and return the main account list. 

ZIC/SY:MTNACC 	MAINTAIN ACCOUNT 
rszs =X 	 10:30:31 

 

	

Command 	0 	 
1 	2 

 

12Cauusel 

 

3txit 4Rafrah 5 	6 	7 	8 	9 	10 
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Figure 6-5 New Account Entry Pop-up 



Display detail 
Remove Application : 
New Application 	: 
Maintain A/C Date : Press r5 

Account NUmber TIST001 	Name 
Start 920201 	Ind 

Application Start 

Press Transmit at Application entry 
Press Transmit under Rey 
Press r6 

ACCTO5 	 TEST001 
Enter new date and press transmit to amend 
Date format is YYMMDD 

Creation : 920114 	Last Update : 920114 

Icoonnt Name 	(Documentation Test 

Start Date 	(9202013 
Ind Date 	[9202023 
Review Date 	(920202] 

Account & Application Registration 

6.1.3 Account Maintenance - Review Dates 

On the main account list, type in the Account Name on the Command Line or roll to 
select the account. This will cause the maintenance screen for the selected account 
to be displayed. 

ILIC/SY:MTNAPP 	MAINTAIN APPLICATION =ACCOUNT 
raz HELP 	 10:39:09 

Display detail 	: Press Transmit at Application entry 
Remove Application : Press Transmit under Ems 
New Application 	: Press 16 
Maintain A/C Date : Press PS 

Account NUMber TEST001 	Name Documentation Test 
Start 920201 	Lad 920202 

Last 
Application 	Start End 	Review Create Update Row 

Bottom 

Conceind 0 	 12Canoel 
1Help 2 	3ftit 4ReErsh 5ACDate 6AddAp 7 	8 	Main 10 

Figure 6-6 Account Maintenance Screen 

To maintain the account action and review dates, select Function Key 5 (F5) on the 
Account Maintenance Screen. The Account Review Pop-up will be displayed. Alter 
the details as required and TRANSMIT. On completion, the Application 
Maintenance Screen will be redisplayed. 

ZIC/ST:MTNAPP 	MAINTAIN APPLICATION IN ACCOUNT 
FILE HELP 	 10:39:09 

Comma! 0 	 12Canoel 
1 	2 	3Xxit 4Rafrish 5 	6 	7 	8 	9 	10 

Figure 6-7 Account Review Date Pop-up 
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COM 

ACCTO4 	 TZST001 
Enter new Application data and press 
Transmit to register 

Application Name 	 
Sub Account Code  	 3 (if any) 

Start Date 	  [920201] 
And Date 	  [920202] 
Review Date 	 [920202] 

Display detail 	: Press Transmit at Application entry 
Remove Application : Press Transmit under Rim, 
New Application 	: Press 76 
MeintainA/C Date : Press rs 

Account NUmber TAST001 	Name 
Start 920201 	And 

Application Start 

Account & Application Registration 

6.1.4 Tie the Account to the Application 

Select Add Application Function Key 6 (F6). 

The New application pop-up will be displayed. Enter the application name to be 
registered (in this case VIP). Note that the start, end and review dates may be 
altered at this time. For first time through, default dates are taken from the Account 
registration process. 

AIC/SY:MMAAPP 	MAINTAIN APPLICATION =ACCOUNT 
TZtE AiLP 	 10:46:47 

Command 0 	 12Cancel 
1 	2 	Unit 4Rsfrsh 5Prompt 6 	7 	8 	9 	10 

Figure 6-8 New Application Pop-up 
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Account & Application Registration 

Enter the data then press TRANSMIT. The application will now show up on the 
Account Maintenance Screen. Note that there are two entry fields for the 
Application. The field alongside the application name allows setup of the application 
specific details. The RMV (remove) field removes the application from this account, 
once the application specific details have been reset. 

RIC/SY:MUM 	MAINTAIN APPLICATION IN ACCOUNT 
rILA KELP 	 10:51:02 

Display detail 	: Press Transmit at Application entry 
Remove Application : Press Transmit umber Rum 
NOW,  Application 	: Press 1'6 
Maintain A/C Date : Press r5 

Account Number TZST001 	Name Documentation Test 
Start 920201 	End 920202 

Last 
Application Start End 	Reviw Create Update lbw 

mip 	- 920201 920202 920202 920114 920114 

Bottom 

Commandp 	 12Canoal 
1Nelp 2 	Umit 4ReErsh 5AcDate 6AddAp 7 	8 	Main 10 

Figure 6-9 Application Registered for Account 

6.1.5 Define Application Specific Details 

Each application may have specific details necessary to be supplied for proper 
functioning or to identify the specific facilities and functionality to be attached to the 
account. 

To establish the application specific details (in this case for the MIP - Mapper 
Interface to PRIMUS application), tab to the entry field for the selected application 
and TRANSMIT. 
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om 

Remove Specific :Inter Y Alongside and Press Transmit 
Add 	Specific : Press r6 
Amend Appl Date : Press 15 

Appl 	: Start 920201 	End 
Account : ID 	TIST001 	Name 
	 Primus 	 

Site Id 	Application Libra 

ACCTO2 	ADD NIP SPECIFIC TO ACCOUNT 
Enter specific and Press Transmit 

Prima Site ID 
Primas Appl 	[PRIMUS 
Library 	[A-SERIES ] 
Doc Typo 	 

Start Date 	[920201] YYMMDD 

Account & Application Registration 

The MIP account profile screen will be displayed. Specific functionality will be added 
to this screen for use by the account. 

IIC/SY:ACCT01 	MAINTAIN ACCOUNT PROTILI TN MIP 
VIM PUP 	 10:59:09 

Remove Specific : Inter Y Alongside and Press Transmit 
Add 	Specific : Press rs 
Amend Appl Date : Press rs 

ANA 	: Start 920201 	End 920202 	Review 920202 
Account : ID 	TIST001 	Name Docmmantation Test 
<------- Primus 	 
Site Id 	Application Library 	Doc Type 	Start 	Ram 

Bottom 

Conmand ❑ 	 12Cancel 
lIelp 2Set 2 3Zxit 4Rafrsh SApDate 6Add 	7 	8 	Main 10Aotion 

Figure 6-10 MIP Account Profile Screen 

To add specific functionality for MIP, select Function Key 6 (F6). It is possible to 
tailor functionality to a sub-account. Select Function Key 5 (F5) for this. MIP is the 
PRIMUS access application and requires a number of separate document selections. 
These could be entered one at a time using the ADD SPECIFIC pop-up window. 

ZIC/SY:ACC201 	MAINTAIN ACCOUNT PROT= IN NIP 
MI VIEW KELP 	 13:19:46 

Comand ❑ 	 12Causcal 
1 	2 	3lxit 4Rafrsh 5Prompt 6 	7 	8 	9 	10 

Figure 6-11 MIP-Specific Functionality Pop-up 
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Press Transmit at entry for single select 

Application Library 	Document 
PRIMUS 	ASZRIZS 	CSO 
PRIMUS AMMO PIS 
PRIMUS 	ASIR= 	UCP 
PRIMUS 	81000 	CHO 
PRIMUS 	81000 	PLR 
PRIMUS 	81000 	DC? 
PRIMUS 	COM 	CHO 
PRIMUS 	CCU 	PLR 
PRIMUS 	COM 	UCP 
PRIMUS FINANCIAL CHO 

Note : Inter "/" along entry for uultiple 
selection and Press rIC6 to create 

COI 

PROMPT 	 mass Transmit 

ADD MIP SPICIrIC TO ACCOUNT 
specific and Press Transmit 

Site ID 	(SY- 
awl 	[PRIMUS 	] 
	(A-8121:15 	] 

p• 	 

Data 	[920201] YID 

om 

Press Transmit at entry for single select 

Application Library 	Document 
PRIMUS 	ASISIZS 	CHO 	/ 
PRIMUS 	ASSM1113 	PIZ 	/ 
PRIMUS 	ASMIS 	UCP 	/ 
PRIMUS 	91000 	CHO 	/ 
PRIMUS 	81000 	PIS 	/ 
PRIMUS 	91000 	UCr 	/ 
PRIMUS 	COM 	CHO 	/ 
PRIMUS 	CON 	PIS 	/ 
PRIMUS 	COM 	I= 	/ 
PRIMUS FINANCIAL CHO 

Note : Inter "/" along entry for unitiple 
selection and Press rT6 to create 

PROMPT 	 res. Transmit 

ADD NIP SPICITIC TO ACCOUNT 
specific and Press Transmit 

Site ID 
App]. 	[PRIMUS 
	[A-SZRIX3 

Pm 	 

Date 	[920201] YYMMDD 

Account & Application Registration 

To add multiple documents, select Function Key 5 (F5) PROMPT. This provides a 
pop-up window which displays the possible documents available via MIP. Any of 
these can be selected by tabbing to them and transmitting, or multiple selections 
may be made by entering 'P in each entry field. Transmit or Roll (Function Key 8) F8 
saves the selection. When selections are finished, selecting Function Key 6 (F6) 
creates the document list. 

IIC/ST:ACCTO1 	MAINTAIN ACCOUNT PROMS IN MIP 
PILL VIEW MS 	 13:19:46 

Command 0 	 12Cancel 
1 	2 	3Zacit 4Refrah 5 	6 	7 	erwd 	9 	10 

Figure 6-12 Example Document Selection for MIP 

On returning to the MIP account profile screen, the selected functionality is 
displayed. 

ZIC/3Y:ACCT01 	MAINTAIN ACCOUNT PROT= =IMP 
MLR VIEW JUMP 	 13:19:46 

Cansand 0 	 12Canoel 
1 	2 	3lxit 4Rafrsh 5 	6 	7 	8Fwd 	9 	10 

Figure 6-13 Selected MIP Functionality Assigned to the Account 

The necessary actions to tie the selected application to the account are now 
completed. Return to registration main menu for the next step - selecting Function 
Key 9 (F9) returns to the main screen. 
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Remove User 	: Transmit at AccountS 
Rog New User : Transmit at User-ID (Past path: inter Ace 1) 	More : + 
Mtn User In App: Transmdt at User-ID (Past path: inter App) 
Mtn Account 	: Press !if (Past path: inter ari5,AccPE,Appr in command line) 

User-1D User Name 	 Org CCC Account Application 

       

ABDI 	 - Igtedar Abdi 	0505 0510 testi 
AB= 	- Mike Abel 	 0505 0682 testi 
AMAMI= - Sandra Abernethy 	0505 0702 
ADAMS 	- David Adams 	0505 0005 TZST001 
ADM= 	- System Administrator 0505 0810 
ArrAT 	- Laura Affat 	0505 0033 
ALLIC 	- Alex Stevenson 	0505 0810 TIST2 
ANDESSON2 	- John Andarson 	0505 0312 
ANTHONY 	- Bambara Anthony 	0505 0720 
ATZINNON 	- Tricia Atkinson 	0505 0611 

Account & Application Registration 

6.1.6 Add User to an Account 

Select the user to be added. In this case select 'ADAMS'. 

Tab to the user entry then TRANSMIT. The account list will be displayed. Roll the 
window to locate the account, tab to the account entry then TRANSMIT. 

The user 'ADAMS' is now tied to the account - in this case Account Number 
TES'r001. 

ZIC/Sf:MAZi 	MAINTAIN USIA ACCOUNT AND APPLICATION MINN= 
ITU VICK =LP 	 13:38:53 

More.. 
Command 0 	 12Cancel 
1Relp 2 	3ixit 4Refrsh 5intAcc 6Mark 7 	Bred 	9 	10Action 

Figure 6-14 User 'ADAMS' tied to Account TEST001 

A quicker method of achieving this is to type the account number directly alongside 
the user entry. 
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Account & Application Registration 

6.1.7 Adding User-Specific Facilities in Account 

The facilities added and the screens used are completely application dependent. The 
example described here applies only to the MIP application. 

Select user entry. 

Select Application on Application Selection Pop-up. In this case it will be for the MIP 
application which requires selection of the initial document to be displayed on entry 
and the document types this particular user may access. 

On Application User Profile Screen for MIP, select Function Key 6 (F6), Select All to 
add all selections or alternatively type 'y' against each selection then TRANSMIT. 

The next screen to be displayed allows the administrator to nominate the document 
which will be displayed for this user on initial entry to MIP. If nothing is selected, 
the system makes the first document entry the default. 
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Account & Application Registration 

6.2 Deleting Items From the Registration System 

6.2.1 Disconnecting a User from an Account 

The first step is to delete the User Application specific functions. On the main menu, 
enter the application name in the blank  field alongside the nominated user's entry. 

Alternatively, tab to the menu entry for the user and select the application name 
from the Application pop-up menu. Note if the user is to be completely removed, the 
process must be repeated for each application to which the user has been attached. 

On the Application User Profile Screen, select Function Key 6 - Delete Application 
on Function key set 2. Delete each of the user specific items. 

When completed, return to the Application pop-up window, then back to the main 
menu. 

To finally delete the user from the Account registration system, transmit at the 
Application entry field for the user. 

6.2.2 Disconnecting an Application from an Account 

On the main menu, select Function Key 5 (FK5) - Maintain Application. 

Enter the Application name in the Command field or select the required Account 
name from the list then TRANSMIT. 

On the Account functionality maintenance screen (Maintain Application in Account), 
for each application registered, tab to the Application entry field and delete the 
Application -specific selections. Note that this step is application dependent. 

Once the Application-specific selections have been deleted, return to the Application 
functionality maintenance screen and tab to the Application remove (RMV) field 
then TRANSMIT. This will delete the Application connection. 

6.2.3 Deleting an Account 

Select Function Key 5 (FK5) on the main menu - Maintain Account. 

Tab to the remove field (RMV) and TRANSMIT. 
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Management Reports 

Section 7 

Managem nt R ports 

7.1 The Basic Reports 

The following Management Reports are provided as part of the basic EIC 
deliverable. 

• User Profile Report. 

• Resource Utilization Report. 

The Management reports may be accessed via the Admin pull-down menu and 
choosing Reports. 

R I. 	Ed It VI ow rt pians   Wind OW   H 

Figure 7-1 Admin pull-down Report Selection 
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Management Reports 

The system will display a selection window, select the required report then 
TRANSMIT. 

IIC/SY:8011311 	AMIC: Australian Marketing Information Centre 	Ln: 1 of 12 
rile 	Zdit 	View 	Options lAdmin I Help 	 15:10:04 0 

RZPORTS - Management Reports 
X 1 BOOK 
M 2 DIPARTKENTS 
M 3 00 
M 4 GRAPHICS 
X 5 INDUCTION 
A 6 I/MINT= 
A 7 MASISM 
A 6 OLD-AMSC 
X 9 PRISS 
M 10 SILL 
M 11 SYSTIMI 
X 12 WORKBENCH 

Press Transmit lay with cursor positioned to the 
Subject you want. 

0_ Report - Profile And Associated User 
0_ Report - Resource Utilization 
0 _ Report - Operation 
0_ Chart - Resource Utilization 
0_ Chart - Operation 

Bottom 
Command 0 	 12Cancel 
1 	2 	Slxit 4Refrsh 5 	6 	7 	8 	9 	10 

Figure 7-2 Management Report Selection Window 

7.2 	Profile and Associated User Report 

Two options are presented: 

• A summary report; this details the Parent and Child profiles in use and the 
number of users registered in each. 

• Report by specific User Profile. 

7.2.1 Summary Report 
ZIC/SY:MRPRO01 
	

Profile Summary 92/02/14 	 Ln: 1 of 155 
rile View Options Help 	 16:02:41 0 

ZIC/SY Management Report 
MESA001 	Profile Summary As At 92/02/14 

<I 

SZQ Parent Prof Profile Description No. Of User 

1 ADMIN AMSC Administrator 2 
2 ADMITS Unisys Administrators 0 
9 AMIC AMIC-Public User 3 
4 AMIC-ADMIN 2 
5 AUSTRALIA Anstralia 2 
6 BA Branch Administrator 3 
7 SD Business Development 0 
8 BM Branch Managers 5 
9 BR-ADMIN 1 

10 BR-SUPPORT Branch Support Managers 2 
11 BSM Branch Support Managers 0 
12 BUS-PLAN-MGR Business Planning Managers 0 

Command 0 	 12Cancel 
tHelp 2 	=zit 4Refrsh 5 	6Right 7 	BPwd 	Main 10Action 

Figure 7-3 Profile Summary Report 
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USER NAME Parent Prof Profile 

BA 	 BA-NSW-T132 - BA -NSW-FIN2 Total 	0 

EIC/SY Management Report 
2222002 	Nominated Profiles As At 92/02/14 

ADM= 	 Sharon Soler 	 Alex Stevenson 
ADM= 	- AMIC Administrator 	 Total 	2 

RA 	 BA-TAS 	Patricia Curran 
8A 	 BA-TAS 	- BA-TAS 	 Total 	1 

LND Or REPORT 2222002 

Management Reports 

7.2.2 Nominated Profile Report 

On selecting this report, a selection window is presented_ To select the Profile(s) 
required, enter '/' character in the field associated with each Profile, then 
TRANSMIT. (Rolling forward saves the selection.) 

ZIC/SY:11222001 	 Profile Summary 92/02/14 	 Ln: 1 of 155 
rile View Options Help 	 16:02:41 0 

Profile And Associated 
Then press 

- 2222D02 

User 

2222001 

SZO Parent 

1 
2 
3ADMIN 
4 BA 

613A 

7_ 

9I24 

10—  
11—  
12 

LIC/SY MI Later choice of report. 
Profile Sum' 

Management Report 

tranemit key. I 

 	Later / to select profile. 	122 to nest page if applicable. 
to produce report. 

ADIEMTIS 	MCC 	 AUSTRALIA. — 	 — 	 — 
RA-ACT 	 BA-NSW-CT 	BA-Nor-ma _ 	 _ 	 _ 
BA-NSW-PS 	BA-NSW-VAM 	BA-QLD _ 	 — 	 — 
BA-TAS 	 BA-VIC-CT 	BA-VIC-FIN — 	 — 	 — 

_ BA FA 	_ 	 _ A 	 BD 	 BD-rca 
BD-QLD 	 BD-VIC 	 BM — 	 — 	 — 
)3b1-NSW-CT 	Est-NSW-TIN 	BM-NSW-1TEI2 — 	 — 	 — 
BM-NSW-VAN 	Ell-QLD 	— BM-SA — 	 — 

— MI-VIC-CT 	— BM-VIC-TIM 	— BM-VIC-PS 
BM 	BM-WA 	 BR-SUPPORT — 	 — 	 — 

5BA-NSW-n:1M 

8 BD-NSW 

Press transmit 

— 
_ 
— 
_ 	-SA 

BA-VIC-PS 

— 
— 	-ACT 

Bbf-NSW-PS 
1381-TAS 

— 814-VIC-UT 

Command ❑ 	  12Cancel 
1 	2 	32xit 	4Refrah 5 	6 7 	8rwd 9 	10 

Figure 7-4 Nominated Profile Report 

The following report details are presented by the system 

IIC/SY:MRPR002 
	

Norminated Profiles 92/02/14 	 Ln: 1 of 15 
rile View Options Help 	 16:05:20 0 

Bottom 
Command 0 	 12Cancel 

1Help 2 	3Axit 4Rafrsh 5 	6Slight 7 	8 	Main 10Action 

Figure 7-5 Nominated Profile Report 
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LIC/ST Management Report 
BBB:TLC' 	Utilization Summary By'llifoftoup AA At 92/02/14 

Info Group 
Orga Cost 
Coda Cntr Lines 
	 Total 	 

Bytes aq 

DOCUMENTPOOL 0000 0000 35 4.07 
BILP 0000 0000 37 4.28 
mama 0000 0000 188 20.44 
=MENU 0000 0000 679 83.78 
SAMS 0000 0000 105 11.56 
PATC 0505 0173 69 8.01 
SOPTWARA 0505 0211 115 11.80 
STURCOM 0505 0250 18 2.25 
2200-916 0505 0312 36 4.17 
ASARIBS-PM 0505 0312 36 4.17 
PC-PM 0505 0312 36 4.17 

Management Reports 

7.3 Resource Utilization 
The objective of this report is to provide system usage details (in MAPPER terms) for 
charge-out purposes. 

Individual reports may be selected as follows: 

• Summary by InfoGroup. 

• Details by Nominated InfoGroup. 

• Details by Organisation and Cost Centre. 

A 12 month history is also available from the selection window. 

7.3.1 Summary by InfoGroup 

ZIC/ST:AMMUL01 	Utilisation Summary By InfoGroup 92/02/14 	Ln: 1 of 85 
Pile View Options Help 	 16:09:27 0 

02:amend 0 	 12Canoel 
2 	3Lxit 4Rafrah 5 	alight 7 	 8Twd 	Wain 10Aation 

Figure 7-6 Detail Summary by InfoGroup 
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RIC/SY:MMUTL01 
	

Utilization Summary By InfoGroup 92/02/14 	La: 1 of 95 
Pile View Options Help 	 16:09:27 
	  Resource Utilization 	  
I Enter choice and press transmit key at date of report you want. 

	 Management Report -MRUTL02 	  
Inf Enter / to select InfoGroup. PIM to next page if applicable. 
--- Press transmit to produce report. 
DOC 	  
RIM / 2200 2200-PM 	ACC-REC 	ACCOUNTING - 	 - 	 - 
MAI -  ADM= 	- 	 - 	 - ASD 	 ASZRIZS 	ASZRIZS-PM 
MIKASIA 	 AUSTRALIA 	BAD 	 BARINA - - 	 - 	 - 
NENCONKS 	 CONY 	 CONNECT 	CTOS - 	 - - 	 - 
PAT- 	 - 	 - CTOS-PH 	DATABASES 	DOC 	 DOCUMENTPOOL -  
SOP _ EDI 	 EDUCATION 	pia 	MANCE - 	 - 	 - 
SYN _ 	 GOVT 	 HELP 	 HR - 	 - 	 - 	 - 
220INDEX 	INDUCTION 	MNPOCENTRE 	INTOIMAGE - - 	 - 	 - 
ASZ =max 	LEGAL 	LINC 	 LOB-METG - - 	 - 	 - 
PC- m-rmacom MAIN 	 MAPPER 	MEM - - 	 - 	 - 

Management Reports 

7.3.2 Summary of Nominated InfoGroup 

A selection window detailing all available InfoGroups will be displayed. Enter 'I' 
character in the input window for each report required, then TRANSMIT. Note that 
the selections are saved if the window is rolled forward. 

More.. 
Command 0 	 12Cancel 
1 	2 	3Lxit 4Refrah 5 	6 	7 	Med 	9 	10 

Figure 7-7 InfoGroup Selection Window 

The summary report is displayed, giving details of MAPPER usage for the selected 
InfoGroup(s). 

EIC/SY:MROTL02 	Utilization By InfoGroup 92/02/14 
	

Ln: 1 of 18 
Pile View Options Help 	 16:13:28 0 

EIC/SY Management Report 
MDT= 	Utilization By InfoGroup As At 92/02/14 

Orga Cost 	D   Count 	 Average 
Info Group Code Cntr Cab R Siz Type Report Total Ln Ln / Rpt 

2200 	0505 0681 028 H 100 NMSC 	2 	85 	43 

2200 	0505 0681 028 1 080 DOCU 	1 	2 	2 

2200 	0505 0681 028 H 100 SCAN 	4 	69 	17 

2200 	0505 0681 028 I 132 DOCC 	1 	20 	20 

2200 	 InfoGroup Total - 	176 Lines ( 20.30 K Bytes) 

More.. 

0 

Command 0 	 
1Help 2 

  

12Canael 
3Exit 4Rafrsh 5 	6Right 7 9 not Wain 10Action 

Figure 7-8 Nominated InfoGroup MAPPER usage details 
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NMDTL03 	Utilization By Org i CCC As At 92/02/14 

Orga Cost 
Coda Cntr 

D 
Cab R Sir Type Report 
	 Count 	 

Total Ln 
Average 
Ln / Rpt 

0505 0173 028 B 100 RISC 2 17 9 

0505 0173 028 3 090 DOCU 2 4 2 

0505 0173 028 H 100 SCRN 3 48 16 

0505 0173 CCC Total 69 Lines ( 8.01 X Bytes) 

.1.71.CT 

EIC/SYSianagemsuat Report 	 1 
MRDTL03 	Utilization By Org i CCC As At 92/02/14 

Management Reports 

7.3.3 Details by Organisation and Cost Centre 

The following report is displayed. 

XIC/AT:NROTL03 	Utilization By Org t CCC 92/02/14 	Ln: 19 of 929 
rile View Options 	Help 	 16:19:09 0 

Comand ❑ 	 12Cancel 
1Help 2 	Malt 4Refrsh 5 	6Right 7Bkwd 87wd 	Main 10Aotion 

Figure 7-9 Report by Org and Cost Centre 

7.3.4 History Report 

Choose a basic report selection, then tab to the History Selection date entry and 
TRANSMIT. 

nymmunas Utilization By Org i CCC 92/02/14 	Ln: 18 of 129 
Tile Wee Options 	Help 	 16:18:09 0 
	  Resource Utilization 	  

NRDTLOS 	1 Inter choice and press transmit key at date of report you want. 
1 	  

Orgal 
Codel (_] 	1. NMDTLOI - SUMMary By InfoGroup 

2. NMDTL02 - Detail by Nominated InfoGroup... 
05051 	3. NMDTL09 - Detail by Org t CCC 

1 
05051 

05051 
	  Current Status As At 

05051 920214 
1 

.11011CT 	1 	 History As At (Max 12 Month History Available) 	 
1 9201 9112 

MRDTLOS 	1 
	 1 	  

Bottom 
Command C 	 12Cancel 
1 	2 	31.xit 4Rafrah 5 	6 	7 	8 	9 	10 

Figure 7-10 History Report Selection 
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7.4 Operations Reports 
The purpose of these reports is threefold: 

• To give the EIC Administrator a 'feel' for overall system growth and usage. 

• To highlight any unusual growth areas. 

• To allow the InfoGroup owners and the system Administrator to manage the 
EIC Wastebasket area. 

7.4.1 InfoGroup Reports 

Four reports are provided in this area. 

7-7 

AMC: Australian Marketing Information Centre 	in: 1 of 12 
View 	Options lAdmin I Help 	 15:10:04 
	  Report -  Operation 	  

Inter choice and press transmit at Section A or B if applicable. 

Section A B 
[_7 	1. MMAYR01 - InfoGroup Menu Activity... 	 Y Y 

2. MROPRA2 - InfoGroup Growth Rate... 	 N Y 
3. MROPR03 - InfoGroup Update Rate... 	 N N 
4. MR0PR04 - InfoGroup Wastebasket Status... 	Y N 

RIC/SY:MA=1 
Tile Mit 

M 1 
If 2 
X 3 
X 4 
M 5 
A 6 
A 7 
A 9 
X 9 
X 10 
X 11 
X 12 

-- Section A 
920306 

 

Current Status As At 

 

  

-- Section B 	 History As At (Max 24 Monthly History) 

Bottom 
Command  	12Canael 
1 	2 	3lxit 4Rafrsh 5 	6 	7 	8 	9 	10 

Figure 7-11 InfoGroup Reports Selection 



InfoOromp Mann Activity 92/03/06 
Options 	Help 
	  Report - Operation 	 

Enter choice and press transmit at Section A or B if applicable. 

Section A B MRDPRO1 

SIC/SY:MROPR01 
rile View 

Ln: 1 of 16 
15:13:12 

Management Report - NROPRO1 
Enter / to select InfoOrocp. 7E8 to next page if applicable. 
Press transmit to produce report. 

InfoOroup 
/ 2200 	 2200-PM 	ACC-RIC 	Accosnarma 
— JUNO]; 	ASD 	 AMU= 	

_ 
ASZATES-PM —  

ASIA 	 AUSTRALIA 	BAD 	 SARIN& — — 	 — 	 — 
COWLS 	 cor 	 CONNECT 	CTOS — 	 — — 	 — 
CTOS-PM 	DATARASZS 	DOC 	 DOCOMENTPOOL — 	 — 	 — 
IDI 	 EDUCATION 	TEA 	 MAIN= — 	 — 	 — 
MASH 	— GOVT 	 HELP 	 RR — 	 — 	 — 	 — 
INDEX 	 li:i/JUS. SON 	ntroccamus 	ISTOINAOS — 
=room 	

— 	 — 
LEGAL 	ZINC 	— LOB-MBTO — — 	 — — 

=TO M-SYNKRCOM 	NUN 	 MAPPER — — 	 — 

2200 

2200 

SIC/SY Management Report 
MROPR01 	InfoOroup Menu Activity As At 92/03/06 

Item 
InfoOromp Description 

Mann 	Month 	Last 	Last 12 
ID 	To Date Month Months 

         

2200 	Conference Menu 	220010 	0 	0 	0 
MS= 	 220011 	0 	0 	0 

220012 	0 	0 	0 
22009 	2 	0 	0 

2200 	 Total 	2 	0 

---- END Or REPORT ---- 

Management Reports 

InfoGroup Menu Activity 

Enter selection 1 and the date range necessary from Section A (current status) or 
Section B (history). 

A pop-up will be presented to allow InfoGroups to be selected for reporting. 

Maze.. 

	

Command  	 12Cancel 
1 	2 	3lxit 4Refrsh 5 	6 	7 	arwd 	9 	10 

Figure 7-12 InfoGroup Selection - Reporting 

The system will report against the InfoGroup(s) selected. 

The following example is for a single selection. 

RIC/ST:MROPRO1 
	InfoGroup Moms Activity 92/03/06 	Ln: 1 of 16 

rile View Options Help 	 15:13:12 

Bottom 

	

Command  	 12Cancel 

	

=alp 2 	3Exit 4Reirsh 5 	6Right 7 	8 	Main 10Action 

Figure 7-13 Sample Menu Growth Report - Single Selection 
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InfoGroup Growth Rate 

This report is based on historical growth rates. Enter the selection number then 
choose the required history period from Section B of the input menu. 

A pop-up will be presented which allows specific InfoGroup(s) to be chosen to report 
against. 

The system will display a report showing growth by InfoGroup. 

InfoGroup Update Rate 

Select item 3 from the menu selection. 

A pop-up will be displayed, select the required InfoGroups and the date range. 

IIC/BY:MROPR01 	InfoGroup Menu Activity 92/03/06 	in: 1 of 16 
Tile View Options Help 	 15:13:12 

Management Report - MBDPRO3 

7-9 

Inter Date, Section A S B selection. Press transmit to create report. 

MA Update rate between (920101] to (920401] =IMOD) 

-- Section A 	 Select InfoGroup by / 
/ 2200 — 	 — 	 _ 2200-VM 	ACC-RBC 	ACCOUNTING 

In _ 	 _ ADWIN 	 ASD 	 ASZRIRS 	 ABLATES-PM 
--— 	 — 	 — ASIA 	 AUSTRALIA 	BAD 	 BARINA 
22 —  COMM 	— 	 — COST 	 CONN= 	CTOS _ 

CTOS-PM 	DATABASICS 	DOC 	 DOCOMMNTPOOL — — 	 — 	 — 
IDI 	 EDUCATION 	P&X 

— 
	

— 
	

- HR 
rxmlucz _ 

!LASH 	 GOVT 	 HILT — 	 — 	 — 	 — 

-- Section B 	 Select Item Type by /, blank input for all 	 
Conference Menu 	Bulletin Board 	Conference It (Ope — — 

— — Document 	 Farm 	 _ Graphics 

200 

More.. 

	

Command 	 	 12Cancel 
1 	2 	31mit 4Refrsh 5 	6 	7 	8 Tod 	9 	10 

Figure 7-14 Update Rate Selections 



Management Reports 

A pop-up will be displayed to allow selection of the EIC component 

lIC/SY:WROPRO3 
file 	View 

InfoGroup Update Rate 92/01/01 
Options 	Help 

- 92/04/01 	Ln: 1 of 21 
15:18:48 

BIC/SY Management Report 
MROP283 	InfoGroup Update Rate 92/01/01 - 92/04/01 

Update 
InfoOroup 	Item 	 Count 

2200 =LIT= BOARD 0 
COMPBRINCI ITEM (CLO 0 
CONMENCZ ITEM (OPZ 0 
COMPERZHC6 MENU 0 
DOCUMENT 0 
FORM 0 
GRAPHICS 0 
MAPPER RUN 0 
MR= 0 
PICTURE 0 
SUMMARY ONLY 0 

More.. 
Command  	 12Cancel 
1Help 2 	3lxit 4Refxsb 5 	6Right 7 	(Med 	Main 10Aotion 

Figure 7-15 InfoGroup Update Rate Report 

Wastebasket 

Select item 4 from the Report menu. 

A pop-up will be displayed which allows selection of the required InfoGroups. 

Select the required InfoGroup (use V' to identify) then TRANSMIT. 

The system will provide summary report by selected infoGroup. 

ZIC/SY:WROPRO4 	InfoOroup Wastebasket Status 92/03/06 	Ln:1 of 9 
Pile View Options Help 	 15:20:53 

	

EIC/SY Management Report 	 <I 
MROPRO4 	InfoGroup Wastebasket Status As At 92/03/06 

	Document 	 Total Last 
InfoGroup Description 	Maxi= Current '41 Poll Lines Update 

2200 	2200 Product Info 	999 	0 	0.00 	5 920302 

---- END or REPORT ---- 

Bottom 

	

Command  	 12Cancel 

	

1Help 2 	3lxit 4Refrsh 5 	6Right 7 	8 	Main 10Aotion 

Figure 7-16 Wastebasket Report By Selected InfoGroup 
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Section 8 

User Education 
This section tells you what the different kinds of people using EIC need to know in 
order to use EIC effectively. 

8.1 Users 
Users use EIC as a source of information. They need to know how to: 

• Log on to EIC; 

• Use the Menu Bar in EIC; 

• Locate information in the menus keyword, text search; 

• Use their private MyMenu and NotePad; 

• Send Electronic Mail with EIC, as documents or data from a form, print; 

• Get help on problems. 

8.1.1 Logging on to EIC 

Logging on to EIC involves several things which can be specific to each individual 
user. 

They are: 

• The type of machine that they use, for example, a dumb terminal or a 
workstation. 

• The type of data communication link between the machine and the EIC host 
system. This could be via a local area network, a dial-up connection using a 
modem, or a permanent circuit which uses a leased line. 

• Any terminal emulation software used by a workstation. 

• Security access to the host computer, ie username and password. If a user 
needs help with anything mentioned above, help may need to be obtained from 
either a technical specialist at the user's site, or, in the case of security access, 
from your MAPPER coordinator. 

8.1.2 Use of the Menu Bar within EIC 

Initially, you should show a new user how to use the Menu Bar. The options are 
documented in the EIC User's Guide. 
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8.1.3 Locating Information 

The instructions you can give a new user are: 

To locate the information, start at the main menu and look at its contents. Select the 
most relevant item, and repeat the process while the item you selected is a sub-
menu. You can use a keyword search to help you locate an item within a menu. If 
you should wish to search for information within a document, you can use a text 
search when the document is displayed on the screen. 

8.1.4 Using "MyMenu" & the NotePad 

The instructions you can give a new user are: 

Your MyMenu contains information you access frequently. You can copy specific 
information from the main menu area to your MyMenu and vice versa. You can use 
your notepad to create documents or hold notes. 

8.1.5 Printing Documents 

Documents can be printed to the screen, a printer connected to your 
terminal/workstation, or a printer connected to the host computer. 

8.1.6 Information Providers 

Information providers generate information with EIC. They need to know 
everything a user knows about EIC, as well as how to: 

• Enter information into EIC; 

• - 	Categorize information by using keywords; 

• Restrict access by profiling information; 

• Create summaries for documents where appropriate; 

• Put new information into the appropriate menu. 

8.1.7 Entering Information into EIC 

You can either import documents and graphic images from the host computer or 
enter them from your terminal/workstation. You should know how to use the update 
facility to enter information into a document or into the notepad. 
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8.1.8 Categorize Information by Using Keywords 

Before you categorize an item in a menu, you should check the keyword list for that 
menu. If possible, use existing keywords to classify your information If this is not 
possible, you should create a keyword which has a clearly separate meaning from 
any previously defined keywords. 

8.1.9 Restrict Access by Profiling Information 

Profiling information is done so that the information is available only to people who 
have certain roles within the corporate structure. If there are no profile keywords 
available which can be used to define access to the document, then the system 
administrator should be contacted to arrange for changing the profiling system. 

8.1.10 Create Summaries for Documents Where Appropriate 

You should summarize information when you are able to give a brief overview of 
what the information is about. 

8.1.11 Put Information into the Appropriate Menu 

If you cannot find an appropriate menu to put new information in, it may be 
appropriate to create a new menu or modify an existing menu. When you do this, it 
should be clear to other people how the organisation of the information has changed. 
If necessary, you can create a summary as an item in part of the menu. 

8.2 InfoGroup Owner 

An InfoGroup owner is responsible for all of the information within a specific 
InfoGroup. The owner of the InfoGroup may have up to 36 assistant owners. The 
owner and assistants all have read and write access to all information within the 
InfoGroup. An InfoGroup owner (or assistant) needs to know everything that an 
information provider knows about EIC, as well as how to: 

• Organise information within the menus; 

• Respond to queries about information within the InfoGroup. 

8.2.1 Menu Organisation 

You should organise menu items so that the distinction between items in any menu 
is clear. 
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8.3 	Systems Administrator 
The system administrator is responsible for the efficient running of EIC . The 
system administrator may be solely responsible for EIC, or may work in conjunction 
with other system administrators. The administrators should know everything 
about the use, operation, structure, and maintenance of EIC. The central issues in 
being a system administrator are: 

• Being aware of how people interact with EIC; 

• Communicating with other system administrators about your current EIC 
information management issues; 

• Talking to your MAPPER coordinator about system performance and resource 
issues; 

• Giving training and advice to people on the use of EIC. This advice should 
centralize on the structuring of information and the answering or redirecting 
queries from users. 

8-4 



Spreadsheet 
Details 

Drill Down EIC 

ICON 

Executive View Manager 

Section 9 

Executive View Manager 
9.1 Overview 

The Enterprise Information Centre (EIC) View Manager is intended to allow 
business analysts to define end-user views of data. extracted from nominated 
financial and / or business systems within an enterprise. The required data is 
extracted or manipulated by small individual programs specific to the reporting 
requirement which may then be stored in a Management Report Library (MRL) 
associated with EIC. End-users are able to access this information by selecting 
prestructured views from an EIC menu. with each view able to be further 
manipulated by the end-user using EIC workstation functionality. Access control, 
security. administration and entitlement is managed by EIC. 

9.1.1 User's View 

Graph 

Figure 9-1 User's View - Simple Case 

In this illustration of the simplest case. the user positions the mouse pointer then 
'clicks' on the required Icon on the EIC menu of available views. The system then 
downloads all of the available views attached to that root Icon to the user's 
workstation and displays the first view. which in this case is a graphical chart. 
Using the workstation functionality. the user can then drill-down further to the 
underlying spreadsheet. 

9-1 



Executive View Manager 

The EIC workstation functionality allows the user to change the graphical 
presentation or the underlying spreadsheet for redisplay. The result can be exported 
to an external spreadsheet package, stored as a DOS file, comma-separated file, 
printed. etc. 

9.1.2 Chained Views 

The EIC workstation software allows graphical presentations to have active areas. If 
the user positions the mouse pointer and 'clicks' on an active graph area, an 
information box is displayed which shows the numeric value of that section of the 
graph. If another view is 'chained' off the selected portion, the information box 
display s a 'Chained View' Icon. On 'clicking' on this Icon, the next lower view is 
presented. The process may be repeated for as far down in the chain as there are 
graph charts. until the final view is presented. The final view is always a 
spreadsheet report of data selected from the Management Report Library. 

USER'S VIEW - DRILL DOWN 

GRAPH 

9-2 

BC ICON 1 	BC 
T SPREADSEET  

BC 
S P 

READS 
HEET GRAPH 

BC 
SPREADSEET 

REPORT 
DETAILS 

REPORT 
DETAILS 

REPORT 
DETAILS 

o REPORT DETAILS ARE DISPLAYED AS 
SPREADS EETS ON BC WORKSTATION 

Figure 9-2 User's View - Drill Down 
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9.1.3 Constructing Views 

Figure 9.3 shows the relationship between the major components that make up the 
Executive View Manager capability of EIC. Data is brought into the system 
dynamically or into a local repository from which selected row and column 
information is brought together to form discrete end-user defined views. A business 
analyst defines each view using the Administrative capability of the View Manager. 
The Database access manager is used to define the source of the data for a particular 
view - views may be constructed from periodic data (MRL) or by realtime access to a 
remote database or application. 

— Local 

	Remote Databases 

D 
B 	OLTP Transactions 

A 
M 	Application Databases (Mapper) 

SQL 

Management Report Library 

-4— Financial 
Reports 

.40,_ Excel 
spreadsheets 

"0—  Personnel 
Info. 

-4—  Etc, Etc 

Database 

Access 
Manager 

Figure 9-3 Overview - Constructing Views 
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9.1.4 Support Domains 

Figure 9-4 shows an overview of the general areas of organisational responsibility so 
far as system establishment. maintenance or support is concerned. Development and 
maintenance of views is seen as the responsibility of the business analyst function 
and clearly rests in the end-user domain. Maintenance of the Management Report 
library table structure. data sources or application access is the responsibility of the 
IT organisation (database support function). 

Business 
Anaiyst 

/DBA 
Business Analyst 

SQL 
Tables 

Description 
ColtrrinrJRows 
Access Method 

4 	 

External 

SYstem 

User 
Mew(s) 
Graphs 

Report 

  

    

Analyst 

Figure 9-4 Support Domains 

9.1.5 	User Registration 

User registration and access control to the EIS capabilities constructed with the EIC 
Executive View manager functionality. is managed within the normal EIC User 
registration capability. 
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9.1.6 	View Manager - Administration 

Note: Terminology used in this description of the View Manager is based on SQL 
standards and at times may be at variance to Unisys proprietary MAPPER terms. 

Icon 

Figure 9-5 View Administration Flow 

The View Manager administration capability is broadly structured as shown in the 
preceding diagram and the three major elements which have to be defined are: 

• Tables which define the data elements which will be selected from the 
Database Access Manager. 

• Reports which present the selected data elements in tabular format. 

• Graphs which allow the report to be shown in chart form. 
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9.1.7 View Chaining 

Views may be chained together in a hierarchical manner so that the required 'drill-
down' capability may be implemented. The underlying reports may be displayed and 
manipulated at each level of the 'drill-down'. This is illustrated in Figure 9-6. 

Figure 9-6 Drill-Down 

It must be remembered that the mechanism is completely flexible and that the 
structures described in the following sections are examples of possible approaches. 
The functionality utilises Windows 'point and click' functionality. The presence of 
prompt lists or additional fields is indicated by buttons or scrollbars - do not hesitate 
to investigate these. 
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Grp T TMP 
Nus F GRP Graph Title 

Contact resolution (goal 55% 12mth 	:NPR%) 

Report- 

CONT-IP 
CONT-1P 
CONT-IP 
CONT-IP 
CONT-IP 
CONT-1 
CONT-IP 

CONT-1P 
CONT-IPI 

Select a Giaoh and own a command button you want. 

Executive View Manager 

9.1.8 Working with EIC View Manager 

In building Tables, Reports and Graphs, each window is displayed on the 
workstation screen (see Figure 9-7). This means that it is possible to move back and 
forth between each functional step by 'clicking' on the top of the required window. It 
is also possible to display the resultant graph, cancel then return to the Graph 
admin function. This means that the output can be progressively checked as the 
Graph is built. 

Figure 9-7 Working in the Functional Windows 
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9.2 Tables 

9.2.1 View Manager Index Table Relationships 

Table relationships are shown in Figure 9-8. 

Database Access Manager 

9-8 

Figure 9-8 Table Relationships 



AAAA 	RUN 	AAAAAAAAA 
CONT-1 
CONT-2 
CONT-5 
CONT-P 
CONT-S 
REC-SUPP-1 
SHOE00 
SHOE10 
SHOE20 
SHOE30 
SHOE40 
SUB-SUM-0 

0021d086 PACE CONTACT Resolution (Non-UCF) 
0041d086 CONTACT Ratings 
0101d066 CONTACT Escalation Reasons 
01270086 CONTACT Processed by PACE (by PRODUCT) 
01470086 CONTACTs Processed by PACE 
0161D086 Recoverable Support 
00941000 Shoes sales 
00206126 Shoe Sales 
00216126 Shoe People 
00226126 Shoe Salaries 
JOIN 	Shoe Salaries by Branch 
09990086 SUMMARY FOR SUBSIDIARY 

Tables 
Table-ID Data Description 

Select a Table and piers Reports button for Report list, 
or press a command button you want. 

Reports:  fid. rai 

Executive View Manager 

9.2.2 The Database Access Manager Table Index 

The View Manager Administration capability is accessed from the EIC Admin pull-
down. The initial menu is an indexed list of available tables within the Data Access 
Manager. 

Figure 9-9 Data Access Manager Table Index 

As indicated by the function buttons at the bottom of the menu screen, tables may be 
managed by selecting the appropriate function. The required table may be selected 
by clicking once on the table entry before selecting the function to be performed. 

The reports attached to a table may be selected by double-clicking on the required 
table entry, or by selecting the required table entry then selecting the reports 
function. 

Table-Id 	User assigned table name. 
RID ## 	MAPPER Report (RID) number in the Management 

Report 
Library which will be referenced by this table. 

Description 	 User-assigned description for this table. 

Function buttons 

Reports 	 Display reports list assigned to selected table. 

ADD 	 Add a new table. 

Delete 	 Delete the selected table. 

COPY 	 Copy the selected table. 

Modify 	Modify the selected table. 
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Table-ID 	 

Description 	 

InfoGroup-Id 	 

Cab/Drw/Rid# 

Data source 	 

            

       

Default Report-ID 	 

  

            

            

            

       

(Mapper rid# for table column definitions) 

            

Data included 

  

all  	 

    

Executive View Manager 

9.2.3 Adding or Modifying a Table 

When the Add or Modify functions are selected the following definition screen will 
be displayed. Figure 9.10 shows example data for an existing definition. 

Figure 9-10 Table Definition 

Item descriptions: 

Table Id 	User assigned table name. 

Default Report-Id User assigned View Id. (Used for identification in a View list) 

Description 	Summary description of table. 

Cab/Drw/Rid# 	MAPPER Cabinet / Drawer / Rid in which the table resides. 

InfoGroup Id 	InfoGroup in which this table is to be registered. 

Data Source 	Data Included ; MAPPER Run : 
Join table : SQL Relational Database. 
Identifies the source of data to be included in 
the table. 
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Application call to get table data 

Enter Mapper application call statement ; 

NimaMazigezuztgigzMkgp:Mzmi.b,zbp 

YYMM 
Month 
P/P/S 
ORG 
GROUP 
<-- 
---AVG RES 

Left justified 
YMMDD 
Right justified 

Data Format 
Sec 

Column Name 
	

Val Format 

Select column(s) anti liens appropriate button. 
Default format is Left Justified text. 

tance 

Executive View Manager 

9.2.4 Accessing Data Table 

Select the DATA function. the following MAPPER run call menu will be displayed. 
Enter the NLAPPER run call statement, then OK. 

Figure 9-10.1 Data table run call 

9.2.5 Column Data format 

Select the COLUMN function button, the following function menu will be displayed. 
This is intended to allow column data default formats to be specified. To specif a 
format for a particular column, fisrt select the column from the list then select the 
format button. The selection will be noted against the Column descriptor in the 
table. 

Figure 9-10.2 Column Data format selection 
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Date format 

Select a date or time format. 

ymmdd 

yymmdd 

O dd mmm yy 

0 yddd 

• yyddd 

• ddmmyy 

• mmiddiyy 

O month dd, yyyy 

• mmddyy 

hh:mm:ss 

• hh:mm 

• hhmmss 

O hhmm 

Executive View Manager 

9.2.6 Date and Time format 

Column data can be displayed in preset Date and Time format by first selecting the 
target Column from the list box then selecting the DATE & TIME function. Select 
the default format from the following table. 

Figure 9-10.3 Date and Time format 
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Enter profiles to be matched against user profile. 
[*2  Note: Vertical is OR. Horizontal is AND condit on ) 

Executive View Manager 

9.2.7 Column Security 

Column security is based on the standard EIC security approach where access rights 
are dependent on the User's role definitions. Column security can be implemented 
by first selecting the target Column from the list box then selecting the SECURITY 
function. The following security definition table will be displayed - enter the role 
definitions that are able to access this column. Follow the instructions accompanying 
the table. To assist in selecting the correct profiles, a Profile List function is provided 
at the bottom of each column in the table. 

Figure 9-10.4 Column Security definition table 
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li Line: 1 

PACE CONTACT Resolution (Non-UCF CONTACTsJ 
Non-UCF CONTACTs Resolution by PACE (by Product 
Non-UCF CONTACTs Resolution by PACE (by Product 
Non-UCF CONTACTs Resolution by PACE (by Product 
Non-UCF CONTACTs Resolution by PACE (by Product 
Non-UCF CONTACTS Resolution by PACE (by Product 
Non-UCF CONTACTs Resolution by PACE (by Product 
Non-UCF CONTACTs Resolution by PACE (by Product 
Non-UCF CONTACTs Resolution by PACE (by Product 
Non-UCF CONTACTs Resolution by PACE (by Product 
Non-UCF CONTACTs Resolution by PACE (by Product 

CUNT-1 
CONT-1P 
CONT-1P01 
CONT-1P02 
CONT-1P03 
CONT-1PO4 
CONT-1P05 
CONT-1P06 
CONT-1P07 
CONT-1P08 
CONT-1P09 

CONT-1P 
CONT-1P 
CONT-1P 
CONT-1P 
CONT-1P 
CONT-1P 
CONT-1P 
CONT-1P 
CONT-IP 

Reports 

Report-ID F Template-ID Report Title 

Select a Report and press Graphs button for Graph fist. 
or press a command button you want. 

Executive View Manager 

9.3 	Reports 

A Report is the underlying spreadsheet that is displayed when Drill Down is 
selected on the FILE pull-down menu. The following process describes how to select 
the data required to construct this spreadsheet (Report). 

9.3.1 Maintaining Reports 

When a table entry is selected, the system displays the list of Reports (views) 
associated with that table. Note that as there may be an extensive number of 
reports, scroll bar and locate facilities have been provided in order to help locate the 
required report. 

Figure 9-11 Report Index Menu 

Item descriptions: 

Report Id 

Template Id 

Description 

Locate 	 Locate required report in index. 

Graphs 	 Access graph index attached to selected report. 

Add / Delete / Copy Report maintenance functions. 

Display 	 Display the selected report. 

Close 	 Exit the report maintenance facility. 

Print 	 Print the screen on display. 
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Item descriptions: 

Operation function buttons (right hand side) 

Options 	Report definition options. 

Parameters 	Report input parameter definition. 

Columns 	Column selection definition. 

Rows 	 Row selection definition. 

Colour 	 Colour definition 

View list 	Defines the views which will be attached to this report. 

Security 	Define table security . (See Figure 9-10.3 for definition) 
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Report Definition 

Report-Id 	 

Title 	  

InfoGroup-Id 	 

Template Report...  

  

❑ Template Report definition 

 

Option: 

   

   

   

  

Executive View Manager 

9.3.2 Adding / Modifying a Report 

Add - Select the ADD funtion. 

Modify - Select the OPTIONS function. 

On selecting the required function. a report definition menu is displayed as shown in 
Figure 9-12. Provide the required details then select the OK function - this screen 
can be cancelled by selecting Cancel. Template reports can be selected by accessing 
the Template Report List function. 

Template Report 

If this is to be a report template. enter Y (yes) in the Template Report/Graph 
Definition field. 

Standard Report 

If this is to be a standard report, simply enter the report title then select OK. 
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Figure 

Item Descriptions: 

Report Id 

Template Report Id 

Template Report/Gr 

Title 

InfoGroup Id 

9-12 Report Definition Entry Menu 

User defined report number. 

ID of the template report to be copied (or use Template 
report list.- access by clicking on selector). 

If Y (yes) indicates this is to be a template. 

User defined report title. 

Nominate the IngoGroup to which this report belongs. 
This is an access security requirement. 



Month 	 3 -3 
N UCF rie 
12MTD N UCF 
12MTD  Non UCF Respond ES 
WMM 	(1 -2 

4 

Executive View Manager 

9.3.3 	Defining Report Parameters 

The report parameter definition table is accessed by selecting the Parameters 
operation button. A table as shown in Figure 9-13 will be displayed. Note that 
prompt lists of parameter selections are provided for selected columns in the table, 
these are selected by clicking on the associated button indicators or the entry field 
itself. 

File Help 
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12 
13 
14 

is 
17 
18 

23 

Parameter 

MUM 
	 VALUE 	4: 55 

COLUMN-F1RSTV" 
P 	 COLUMN-FIRST 
YP 	 COLUMN-FIRST* 
ytdnrt 	 COLUMN-FIRSTS 
yq 	 COLUMN 	-FIRST 

	 I 	

 

Parameter Type Constant Valued type 
VALUE 

attectiOVt.. 

Figure 9-13 Defining Report Parameters 
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Item Descriptions: 

Parameter name 

Parameter type 

- Column-first 

- Column-last 

- Value 

- Input 

Constant value if type 
is value. 

Column name to extract 

value if type is Column 

Partial field 

Description  

User-assigned parameter name. 

Type of parameter. 

Parameter value equals Column name (first line). 

Parameter value equals Column name (last line). 

User defined constant value. 

Takes the parameter value from another report -
this is used for Template reports only! 

Constant to be used if a Value type is selected 

Name of the column from which Value is to be 

selected if type is Value. 

Column Number. number of characters. 

Description of the Parameter. 
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9.3.4 Defining Column Selections 

The column definition table is accessed by selecting the Column operation button. A 
table as shown in Figure 9-14 will be displayed. Note that prompt lists of parameter 
selections are provided for selected columns in the table, these are selected by 
clicking on the associated button indicators or the entry field itself. 
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Figure 9-14 Item Descriptions 
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"jaizietwicsew 

Item descriptions: 

Column name 
the 

Length 

Partial field 

Display order 
displayed 

Sort level 

Sort option 
ascending. 

Hide YIN? 

the name for the particular column that will appear in 

user's view. 

length of the column field 

where a column field is to be selected, this defines the 
starting character position within the field then the 
number of characters. 

indicates the order in which the column will be 

in the user view. 

indicates the order in which the columns will be sorted, 
(default is the order in which they are entered). 

N = numeric. D = descending default is alpha / 

Indicates whether the column is to be displayed in this 
view (may be made visible for other views). 
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9.3.5 Defining Row Selections 

The row definition table is accessed by selecting the Column operation button. A 
table as shown in Figure 9-15 will be displayed. Note that prompt lists of parameter 
selections are provided for selected columns in the table, these are selected by 
clicking on the associated button indicators or the entry field itself. 

File Help 

Figure 9-15 Defining Row Selections 

File Help 
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Figure 9-16 Defining Row Selections - Showing Value 2 Field 
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9.3.6 Defining Colour Selections 

The colour definition table is accessed by selecting the Colour operation button. A 
table as shown in Figure 9-17 will be displayed. Note that prompt lists of parameter 
selections are provided for selected columns in the table, these are selected by 
clicking on the associated button indicators or the entry field itself. 

The functionality allows individual and groups of items to be specially coloured. Also 
bands of colours to be established to allow row types to be grouped or simply to make 
it easier to differentiate between rows. 
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Figure 9-17 Colour Definition Table 
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Figure 9-18 Colour Definition Table - Showing Column Name & Key Fields 

Item Descriptions: 

From row no. 	start of range 

To row no 	 end of range 
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Item Descriptions 

Column name 

Partial field 
the 

Operator 

include, 

Value 1 

Value 2 
OR' 

select name from the column selection entry. 

where a partial column is to be selected, this defines 

starting character position of the selection, within the 
field / number of characters. 

logical operators which compare the contents of the 
selected row with the value in Value 1 field and / Value 
2 field. 

Operators are : LT, LE, EQ, NE, GT, GE, IN = 

EX = exclude, TP = top, BT = bottom. 

target value for row selection 

used in association with Value 1 contents as a 'logical 

function. 

9-21 



1 	Contact resolution (coal 55 12ffith avq ;./YPs":%) 

Select a Graph and press a command button you want. 
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9.4 Building Graphs 

9.4.1 Graph Index Table 

The Graphs attached to a report may be accessed by 'double-clicking' on the target 
report or 'single click' then 'clicking' on the Graphs maintenance button at the 
bottom of the Report window. Figure 9.21 shows and example graph table index. 

This index window has maintenance buttons at the bottom and operator buttons on 
the right-hand side. The maintenance buttons are used to add, delete or modify 
graph tables and to display the results of the selections so far built in a current 
table. The operator button (Options, Parameters, etc) are laid out in the logical order 
of progression. 

Figure 9-21 Graph Table Index 
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9.4.2 Changing Graph Title and Options 

The graph title and options may be changed by selecting the Options operator 
button. The entry table is displayed as shown in Figure 9-22. Note that in this 
instance no Template Graphs have been developed. If available, these are displayed 
in the Template Graph area as a selection menu. 

Provide the required details then select the OK function - this screen can be 
cancelled by selecting CanceL 

Template Graph 

If this is to be a graph template, enter Y (yes) in the Template Graph Definition 
field. 

Standard Graph 

If this is to be a standard graph, simply enter the report title then select OK. 

Graph Title and Options 

Figure.9-22_Graph_Options 

Item Descriptions: 
Graph Number 	 User defined report number. 

Template Graph Definition? 	If Y (yes) indicates this is to be a template. 

Title 	 User defined report title. 

Template Graph 	 Menu of graph templates. 
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9.4.3 Defining Graph Parameters 

The graph parameter definition table is accessed by selecting the Parameters 
operation button. A table as shown in Figure 9-23 will be displayed. Note that 
prompt lits of parameter selections are provided for selected columns in the table, 
these are selected by clicking on the associated button indicators or the entry field 
itself. 

Figure 9-23 Graph Parameter Table 

Item Descriptions: 

Parameter name 

Parameter type 

- Column-first 
line). 

- Column-last 
line). 

- Value 

- Input 

Constant value if type is value 

Column name to extract value 

if type is value 

Description  

User-assigned parameter name. 

Type of parameter. 

Parameter value equals Column name (first 

Parameter value equals Column name (last 

User defined constant value. 

Takes the parameter value from another report -
this is used for Template charts only! 

Constant to be used if a Value type is selected. 

Name of the column from which Value is to be 

selected if type is Value 

Description of the Parameter. 
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9.4A Defining Graph Column Selections 

The Graph column definition table is accessed by selecting the Column operation 
button. A table as shown in Figure 9-24 will be displayed. Note that prompt lists of 
parameter selections are provided for selected columns in the table, these are 
selected by clicking on the associated button indicators or the entry field itself. 

Be Help 

Figure 9-24 Graph Cblumn Selections 

the name for the particular column that will appear in 

user's view. 

length of the column field 

indicates the order in which the column will be 

in the user view. 

Indicates the order in which the columns will be sorted, 
(default is the order in which they are entered). 

N = numeric, D = descending default is alpha / 

Where a column field is to be selected, this defines the 
starting character position within the field then the 
number of characters. 

Item Descriptions: 

Column name 
the 

Length 

Display order 
displayed 

Sort level 

Sort option 
ascending. 

Partial sort position 
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Hide Y/N? 	 Indicates whether the column is to be displayed in this 
view (may be made visible for other views). 

9.4.5 Graph Row Selections 

The Graph row definition table is accessed by selecting the Column operation 
button. A table as shown in Figure 9-25 will be displayed. Note that prompt lists of 
parameter selections are provided for selected columns in the table, these are 
selected by clicking on the associated button indicators or the entry field itself. 

Figure 9-25 Graph Row Selections 
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Item Descriptions 

Column name 
the 

Length 

Display order 
displayed 

Sort level 

Sort option 
ascending. 

Partial sort position 

the name for the particUlar column that will appear in 

user's view. 

length of the column field 

indicates the order in which the column will be 

in the user view. 

indicates the order in which the columns will be sorted, 
(default is the order in which they are entered). 

N = numeric, D = descending default is alpha / 

Where a column field is to be selected, this defines the 
starting character position within the field then the 
number of characters. 

Hide Y/N? 	 Indicates whether, the column is to be displayed in this 
view (may be made visible for other views). 
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9.4.6 Selecting the Graph Type 

The Graph type selection table is accessed by selecting the Graph Type operator 
button. 

The selection table is displayed as shown in Figure 9-26- note that ,  the current graph 
type selection and row label are displayed at the top of the table.. 

Figure 9-26 Graph Type Selection Table 

Item Descriptions: 

Graph type 	Selection scrollbar allows required type to be selected. 

Row label 	Selection scrollbar allows Row Label to be selected. 

Options 	Allows rows and columns to be transposed on the output. 

Titles 	 Allows the various sections of the graph to be annotated. 
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9.4.7 Defining Chained Views 

The chained view mechanism is used to define the standard drill-down structure 
originating from an EIC menu Icon. To define a chained view, select the Chained 
View operator function. The chained view table will be displayed as shown in Figure 
9-27. 

file Help 

Figure 9-27 Defining Chained Views 

Item Descriptions: 

Column name 

Chain type 

Value or Row number 

Graph number 

External Report Id 

Selected from the column list 

Defines whether chain is off column or row 

If chain is off row, defined row number to select a row 

Graph number to be displayed 

External report Id which will be displayed by drill down 
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